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Chapter Objectives

After completing this chapter you should:

1. be able to use the Batch Plot Utility 
to select and plot several drawings
unattended;

2. be able to specify which layers and
what drawing areas to plot with the
batch utility;

3. be able to install the Express Tools
from the AutoCAD 2004 CD-ROM,
load the Express menus, and invoke
the Express toolbars;

4. be able to use the Express 
Text commands;

5. be able to use the Express 
Layer commands;

6. be able to use the Express Standard
toolbar commands;

7. be able to use the Express Block
commands;

8. be able to use miscellaneous
Express commands from the pull-
down menus and the command line.

BATCH PLOT
UTILITY AND

EXPRESS TOOLS
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CONCEPTS

AutoCAD 2004 ships with many useful bonus (Express) tools and a batch plotting feature.  Either or
both of these utilities can be installed during the initial AutoCAD installation by ensuring these features
are selected.  Alternately, you can install these features at a later time by inserting the CD, selecting
Install, then selecting Add or Remove Features from the setup utility. 

The Batch Plot Utility is very useful in an office or laboratory where many drawings must be printed or
plotted.  This utility allows you to specify multiple drawings to be printed or plotted unattended.  For
example, a set of drawings can be set up to be printed at night so they are ready for you when you return
in the morning.  

The Express Tools include several utility commands that have a specialized or streamlined usefulness.
Many very powerful and useful features are available, including layer utilities and a Layer Manager, file
utilities, modify commands, draw commands, and commands for blocks, text, layouts, dimensioning,
hyperlinks, and miscellaneous tools.

BATCH PLOT UTILITY

AutoCAD’s Batch Plot Utility is useful in offices or laboratories where many prints or plots are made
because a set of drawings can be assigned for plotting as a “batch” without human intervention.  For
other applications, such as when a number of plots are required as a complete project set, the entire set of
drawings can be saved to a list to simplify plotting the same set again at a later time.  Other specifica-
tions about the drawings to be plotted can be saved, such as which layers should be included in the plot,
drawing areas to plot, and the print/plot devices to use.  A plot test can be used as a  “dry run” to locate
any potential problems before running the batch.  If errors occur during an unattended plot run, an error
log is kept so problems can be tracked.

The Batch Plot Utility requires AutoCAD for operation.  Invoking the Batch Plot Utility in turn starts its
own dedicated AutoCAD session used just for plotting.

Follow these steps to start the Batch Plot Utility:

1. Start My Computer or Windows
Explorer (Fig. 47-1).

2. Locate the C:\Program Files\
AutoCAD 2004\ folder and highlight it.

3. Locate the batchplt.exe file and high-
light it.

4. To launch the Batch Plot Utility, double-
click on the file or right-click and select
Open from the shortcut menu.

Figure 47-1
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Once the Batch Plot Utility is started
(with its own AutoCAD session), the
AutoCAD Batch Plot Utility dialog box
appears (Fig. 47-2).  Two pull-down
menus in this dialog box (File and
Options) allow you to specify which
drawings you want to plot and with
what parameters.  The choices in each of
the pull-down menus are explained next.

File Menu

With this menu you manage the list of
drawings (or “batch” of drawings) you
want to plot.  Drawings selected for plotting appear in the list displayed in the central area of the
AutoCAD Batch Plot Utility dialog box (see Figure 47-2).

Add Drawing…
Use this option to select drawings to include in the list.  The Add Drawing File dialog box
appears (not shown) for you to locate and select the desired drawing(s).

Remove
Use this option to remove selected drawings from the list.  First highlight the desired drawing
name(s) in the list, and then select Remove.

New List…
Use this menu item to clear the current list.  This action is necessary in preparation for creating a new list
or selecting a saved list for plotting.

Open List…
Use this button to select a list of drawings (previously saved) to include in the list of drawings
to plot.

Save List…
When a group of drawings has been selected for plotting, you can save the list for future use
with this option.  The file is saved as an ASCII file with a .BP3 file extension.  The file also
records the options you select for plotting each drawing.

Append List…
This option appends (adds) a previously saved list (.BP3 file contents) to the current list of drawings to
plot.  Using this method, several “sets” of drawings can be plotted in batch. 

Plot
When you are ready to make the plots, select the Plot button.  As AutoCAD progresses through
the plot batch, the current status for each drawing is indicated by a check mark placed just
before the drawing name (if the drawing is plotted correctly) or an “X” mark (if the drawing is

not plotted).  Before plotting, select the options you want for each drawing using the options buttons or
Options pull-down menu.

Figure 47-2
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Plot Test
Selecting the Plot Test option causes
AutoCAD to make a “dry run” of
all the drawings listed for batch

plotting.  In this test, each drawing is
checked to ensure all component parts are
located (Xrefs, linetypes, fonts, etc.) and to
ensure that the selected settings are operable.
Warning messages appear if a problem (or
potential problem) exists.  For example, if an
attached Xref, raster file, font, etc., is missing,
AutoCAD reports it.  A sample Plot Test
Results dialog box is displayed in Figure 47-3.

AutoCAD also creates a log file for each drawing in the batch for the plot test.  These log files are auto-
matically assigned a name beginning with the drawing name, followed by a set of numbers and a .LOG
file extension (such as 8TH FLOOR_1_1_5436.LOG).  Since each drawing is opened in AutoCAD for
batch plotting and for plot testing, the drawing log file gives the time the drawing was opened and other
activity that occurs such as resolving Xrefs.  The sample log is shown below.  

[ AutoCAD - Sun Jul 20 11:20:37 2003  ]————————————————————
Opening an AutoCAD 2004 format file.
Resolve Xref “8th floor plan”: 8th floor plan.dwg
Resolve Xref “8th floor furniture”: 8th floor furniture.dwg
Resolve Xref “8th floor hvac”: 8th floor hvac.dwg
Resolve Xref “8th floor lighting”: 8th floor lighting.dwg
Regenerating layout.
Regenerating model.
[ AutoCAD - Sun Jul 20 11:20:39 2003  ]————————————————————
AutoCAD Express Tools Copyright © 2002-2003 Autodesk, Inc.AutoCAD menu utilities loaded.
Command:

Logging…
To locate problems that may have occurred during an
unattended batch plot, journal log file and error log
files could be checked.  For example, if you set up a
batch of drawings to plot at night and an error

occurred while you were out, the log files would record if the
drawings plotted correctly or not.  Two types of logs can be
created while plotting:  plot journals and error logs.  First, you
must select Enable journal logging and Enable error logging in the
Logging dialog box (Fig. 47-4) before running the batch to plot.  

Enable journal logging
The plot journal is saved in the My Documents folder under the
name BPJOURNAL.LOG.  This log keeps a list of all drawings
that plot correctly during the batch plot session.  The list gives
information about each plot such as the drawing location and
time for each plot, etc.  An example plot journal is shown on the
next page.

Figure 47-3

Figure 47-4
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*** Plot Test Scan of batch list <unnamed> at 07-20-2003, 11:23:24
— Setting up SYSVARs...values were XREFCTL <0>, FILEDIA <1>, CMDECHO <1>, CMDDIA <1>,
SHPNAME <>
— Setting up logfile...
— Scanning drawings in batch...

Checking C:\Program Files\AutoCAD 2004\Sample\8th floor furniture.dwg
— Restoring logfile...<C:\documents and settings\james a leach\local settings\application
data\autodesk\autocad 2004\r16.0\enu\>
— Restoring SYSVARs...XREFCTL, FILEDIA, CMDECHO, CMDDIA, SHPNAME

Enable error logging
When Enable error logging is checked in the Logging dialog box, a log called BPERROR.LOG is created
listing the drawings that did not plot during the batch plot session.  An example plot journal is shown
below.

ERROR: Could not open drawing: C:\Program Files\AutoCAD 2004\Sample\8th floor.dwg
ERROR: Failed to plot drawing: C:\Program Files\AutoCAD 2004\Sample\8th floor.dwg
ERROR: Could not open drawing: C:\Program Files\AutoCAD 2004\Sample\db_samp.dwg
ERROR: Failed to plot drawing: C:\Program Files\AutoCAD 2004\Sample\db_samp.dwg

Options Menu

Your selections from this group of options determines how each drawing is plotted during the batch plot
session.  To specify options for a particular drawing, first select the drawing from the list in the AutoCAD
Batch Plot dialog box (see Figure 47-2), then select the desired option(s)
described below.  Remember, an entire set of options can be set for each
drawing in the batch.

Layouts
The Layouts option produces the Layouts dialog box (Fig. 47-5).
Here you select the layouts contained in the drawing that you
want to plot.  The Show all layouts button produces a list of the

named layouts contained in the drawing.  Multiple layouts can be selected
by holding down the Shift key (to specify a range) or Ctrl key (to select
individual names) when you pick the layout names.

Page Setups
This option produces the Page Setups dialog box shown in
Figure 47-6 where you specify page setups to use during the
batch plot session.  You can select from the page setups con-

tained in the drawing or load other page setups from other drawings by
selecting the browse button in the lower-right corner.

Figure 47-5

Figure 47-6
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Plot Devices
This feature is especially powerful because you can
specify that different drawings in the batch plot session
be plotted with different devices.  First, highlight the

desired drawing from the AutoCAD Batch Plot Utility dialog box
list (see Figure 47-2), then use the Plot Devices option to produce
the Plot Devices dialog box (Fig. 47-7).  All AutoCAD-configured
devices for your system are available to choose from.

Plot Settings
The Plot Settings tab (Fig. 
47-8) of the Plot Settings
dialog box allows you to

specify what area of the selected
drawing you want to  appear in the
plot.  You can also specify the plot
scale for the selected drawing.
Selecting Plot to file does not create a
paper plot but produces a .PLT file.

Layers
The Layers option also pro-
duces the Plot Settings dialog
box, but opens the Layers tab.

(This tab is not available when several
drawings are highlighted from the list
in the AutoCAD Batch Plot Utility dialog
box.)  This tab allows you to indicate
which layers from the selected drawing
should be included in the plot (Fig. 47-
9).  The selected drawing’s layer set-
tings in the Layer Properties Manager Plot
column are read and displayed as On
or Off in the Plotting On/Off column in
this dialog box.

Figure 47-7

Figure 47-8

Figure 47-9
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EXPRESS TOOLS

Installing the Express Tools from the CD-ROM

1. Insert the AutoCAD 2004 CD-ROM.

2. The Windows Setup utility should start auto-
matically.  If it does not start automatically, use
Windows Explorer to find the Setup.exe file on
the CD-ROM and double-click on Setup.exe.

3. From the AutoCAD 2004 installation wizard,
look for Step 5, Install Supplemental Tools, and
select AutoCAD Express Tools (Fig. 47-10, near
the bottom left).

4. In the next screen, select Install to launch the
AutoCAD Express Tools Volumes 1-9
Installation Wizard (Fig. 47-11).

5. Select Next to proceed through the dialog
boxes to accept the license agreement and
install the Express Tools.  After the AutoCAD
Express Tools Volumes 1-9 have been suc-
cessfully installed, select Finish to exit the
installation.

When you launch AutoCAD after completing the Express
Tools installation, the four Express toolbars (ET: Blocks, ET:
Layers, ET: Text, ET: Standard) should automatically be dis-
played in the Drawing Editor (Fig. 47-12).

Figure 47-10

Figure 47-11

Figure 47-12
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In addition, an Express pull-down menu should appear between the Modify
and Windows menus (Fig. 47-13).

If the you close one or more Express Tool tool-
bars, you can reactivate the toolbars by using the
Toolbar command to invoke the Customize dialog
box (Fig. 47-14).  From the Menu Group listing on
the right, select EXPRESS to display the available
toolbars on the left.  Select the toolbar(s) you want
to display, then select Close.

Express Layer Tools Commands

Several useful layer utilities are available in this
set.  The productivity you can gain from these
express commands is well worth the trouble of
loading these menus and toolbars.  These com-
mands operate as an extension to the standard
layer commands, allowing you to accomplish in
one command what might otherwise take two or
three commands or what might require multiple
object or dialog box selections.

Figure 47-13

Figure 47-14

Lman is short for Layer Manager.  Layer Manager allows you to save, restore, and edit layer settings.  With
many drawings you may have certain combinations of layers that are frozen, thawed, on, or off for par-
ticular operations.  For example, you may require a certain combination of layers to be On for making a
plot, while a different set of layers may be On for working with construction lines (Xlines, Rays) or for
creating dimensions and text.  Instead of using the Layer command each time you make a plot and each
time you create and edit Xlines, dimensions, and text, you can Save these settings to be Restored at any
later time.

Layer Manager can also save the current color of the layers.  For example, this feature enables you to
quickly switch between a colored layer set and a black-and-white layer set.  A black-and-white layer set
may be useful if you need to frequently copy and paste drawing objects into Word documents.

LMAN COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Manager… LMAN … … … …
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Lman produces the Layer Manager: Save and Restore Layer
Settings dialog box (Fig. 47-15).  The central area lists the
Saved Layer states (empty when you first begin).  The
options operate as described here.

Save…
Using Save… invokes the Layer State Name dialog box (Fig. 47-16).  Here
you can assign a name to the current layer settings.  Normally, you would
want to specify the desired On, Off, Freeze, Thaw or Color state for each
layer before using this option.  However, once a layer state is created, you
can use Edit… to change the On, Off, Freeze, Thaw or Color state of each
layer.  The layer states are saved in the drawing file, so you can Restore the
layer states whenever needed.  Spaces and other characters are allowed in
the name.

Restore
Highlight a name from the list, then use this option to restore the selected Saved Layer state. AutoCAD
automatically sets the On, Off, Freeze, Thaw and Color settings to those saved under the assigned name.

Edit…
This option allows you to change the layer settings for any named state.  First, select the desired name
from the list, then press Edit.… The Layer tab of the Layer Properties Manager dialog box (not shown)
appears for you to make the desired changes.

Delete
This button deletes a highlighted saved layer state from the list.

Import…
You can import previously saved layer states from a file.  Layer states are saved (with Export…) with a
.LAY file extension.  Importing works well when you have several drawings with the same layer names
and functions (as when similar drawings are created from the same template drawing).  Layer states can
be saved in one drawing, then Exported to a file and Imported to the other drawings.

Export…
Once you have created the desired layer states, you can save them to a file (with a .LAY extension).  The
layer states can be imported into other drawings with Import.…

Options…
Selecting this button produces the Layer Manager: Restore Options dialog box (not shown).  This feature
gives additional power for using and restoring layer states.  Normally, when a layer state is restored, all
the properties of the layers (when the layer state was created) are restored.  However, with this dialog
box you can specify which properties of the layers are to be restored when the layer state you select is

Figure 47-15

Figure 47-16
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COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Change to Current Layer LAYCUR … … … …

made current.  For example, you may have a layer state set specifically for displaying objects in different
lineweights, but want to view the drawing with all lines having the same lineweight.  Simply restore the
desired layer state leaving Lineweight status unchecked.  The Options feature is also especially helpful for
creating new layer states similar to existing layer states by restoring the layer state you want to “clone”
but without restoring the properties you want to change.

Laymch allows you to change the layer of selected objects to the layer of the selected destination object.
This command performs the same function as the Matchprop command (see Chapter 12), but only with
respect to layers (Matchprop can change other properties such as color, linetype, or linetype scale).

Using Laymch produces the following prompt:

Command:  laymch
Select objects to be changed:
Select objects:  PICK
Select objects:  PICK
Select objects:  Enter
2 found.
Select object on destination layer or [Type-it]:  PICK
2 objects changed to layer 0.
Command:

You can use the Type-it option to enter the name of the destination layer:

Select object on destination layer or [Type-it]: t
Enter layer name: text
2 objects changed to layer text.

Laycur changes the layer of selected objects to the current layer.  The following prompt is issued:

Command:  laycur
Select objects to be changed to the current layer:
Select objects:  PICK
Select objects:  PICK
Select objects:  Enter
2 found.
2 objects changed to layer TEXT (the current layer).
Command:

LAYMCH

LAYCUR

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Match LAYMCH … … … …
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Use this express command if you want to turn Off all layers except the layer(s) of the selected object(s).
Several layers can be selected to be “isolated.”  If more than one layer is isolated, the last one selected
becomes the current layer.  The following prompt is used:

Command:  layiso
Select object(s) on the layer(s) to be isolated:
Select objects:  PICK
Select objects:  PICK
Select objects:  Enter
2 layers have been isolated. Layer TEXT is current.
Command:

LAYISO COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Isolate LAYISO … … … …

COPYTOLAYER

When you need two different layers that contain similar (or duplicate) objects, such as “Existing Doors”
and “Demo Doors,” you can use this express feature to select existing object(s), then choose the destina-
tion layer for copied objects from a dialog box.  The destination layer must exist prior to launching this
command.

Command: copytolayer
Select objects: PICK
Select objects: PICK
Select objects: Enter

After selecting the object(s) to copy to the new layer, the COPY-
TOLAYER dialog box opens (Fig. 47-17).  Here you select the des-
tination layer name from the list or use the Pick button to designate
the destination layer by selecting an object on the desired layer.

When you choose OK to exit the dialog box, prompts appear con-
firming your selection (see prompt below).  You can select a new
location for the new objects or press Enter to copy the new objects
to the same coordinates as the original set of objects.

2 objects copied and placed on layer “DEMO”.
Base point or <return> to finish:  PICK or Enter
Specify second point of displacement or <use first point as dis-
placement>: PICK or Enter
Command:

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Copy Objects to 

New Layer COPYTOLAYER... … … … …

Figure 47-17
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The main feature of this utility enables you to view the objects on any layer(s) in a drawing even if the
layers are Off or Frozen.  Laywalk enables you to view objects on any specific layer or any set of layers,
one layer at a time if desired.  Laywalk is best utilized to examine the layer contents of unfamiliar draw-
ings, such as those created by an outside source.  Although Laywalk dynamically changes the Freeze/Thaw
or Off/On state of any layers you select to view, you can choose not to keep the changes made using
Laywalk and restore the original layer visibility settings when you exit this utility.  The LayerWalk dialog
box provides several options and a shortcut menu with additional features to manipulate the visibility of
layers.  You also have access to the Layer Manager utility from the shortcut menu, enabling you to manip-
ulate and save layer states.

NOTE:  Since Laywalk shows the contents of each layer, you may want to use Zoom Extents just prior to
launching Laywalk with an unfamiliar drawing.

Invoking the Laywalk command 
by any method produces the
LayerWalk dialog box.  When the
LayerWalk dialog box first appears,
layers that are visible in the
drawing are highlighted in the list.
For example in Figure 47-18, the
LayerWalk dialog box list indicates
(highlights) the names of all visible
layers in the drawing, but the 
A-FURN-* layers are not visible in
the drawing and are not high-
lighted in the list.  (The drawing
used in this and the following illus-
trations is 8th Floor Furniture.dwg
located in the ...\Sample folder.)

NOTE:  The LayerWalk dialog box
is sizable, so enlarge the dialog
box if needed to see more of the
layer names in the list.  

You can also easily view objects on
each layer individually, one layer at
a time.  To view objects on a partic-
ular layer, select any layer name
from the list.  For example, Figure
47-19 displays only the geometry
drawn on the Xref layer “8th floor
plan|A-WALL-INT.”

LAYWALK COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Walk LAYWALK … … … …

Figure 47-18

Figure 47-19
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To “walk” through the layers, highlight the first layer name from the list, then use the down arrow key
on your keyboard to go through the list and display the geometry on each layer in the drawing, one layer
at a time.

You can also select more than one layer by holding down the left button and dragging your cursor across
the layers to view (or use Ctrl to select single layers or Shift to select a range).  

As an alternative, you can enter
individual layer names in the edit
box at the top of the LayerWalk
dialog box to display that layer.
Wildcards can be used.  For example
entering “A-FURN-*” in the edit box
would display those layers in the
drawing whose names began with
“A-FURN-“ (Fig. 47-20). 

Layer name edit box and Filter
check box
Use a filter to reduce the number of
layers appearing in the list and in
the drawing.  Create a filter by
entering layer names with a
common prefix, then an asterisk,
such as “A-FURN-*” (see Figure 47-20), or enter layer names of an Xref drawing, such as “8th floor
plan*.”  This action creates a temporary filter for the list.  When the Filter box is checked, only those
layers listed in the edit box appear in the list and in the drawing.  With a filter in effect, you can still
select individual names from the list to view the geometry, etc.  Uncheck the Filter box to make all layers
in the drawing appear in the list.  A filter remains in effect until cleared by unchecking the box.
Remember that filters are temporary (useful only during the current LayerWalk session) unless saved.
See “Shortcut Menu,” Save Filter, to save filters for use in subsequent LayerWalk sessions.

Select Objects button
This button (upper-left corner of the dialog box) enables you to select one or multiple objects in the
drawing, then returns to the LayerWalk dialog box with the objects layer(s) highlighted.  This is an excel-
lent way to examine an unfamiliar drawing and find out which layers specific objects were drawn on,
especially when selected objects are on more than one layer.

Purge
Purge deletes layers from the drawing (even if Restore on Exit is checked).  The Purge button is enabled
only if there are one or more unreferenced layers (layers containing no objects) in the drawing and those
layers are highlighted in the list.  Use the Select Unreferenced option in the shortcut menu to locate and
highlight any unused layers, then the Purge button to delete those layer names from the drawing and
from the layer list.

Restore on Exit check box
Restore on Exit means to disregard any changes made to the layer status using LayerWalk and restore the
drawing to the visibility state before using LayerWalk.  Use this option if you want to examine the geome-
try on specific layers of a drawing but then return to work on the drawing without saving any of those
layer visibility changes.  In other words, if Restore on Exit is checked when you Close the LayerWalk dialog
box, AutoCAD returns to the layers displayed prior to using LayerWalk.  If you want to keep the layer
display attained using LayerWalk, but return to work on the drawing, make sure Restore on Exit is not
checked before you close the dialog box.  

Figure 47-20
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Shortcut menu
Right-click in the LayerWalk dialog to display the shortcut menu 
(Fig. 47-21).  

Hold Selection, Release Selection, Release All
If you want to turn on the display of a set of layers, then select other
layers from the list to examine the geometry in the drawing, use Hold
Selection.  For example, in an architectural setting you could highlight the
floorplan layer names, use Hold Selection to keep those layers visible,
then select other layer names to display that geometry within the context
of the floorplan.  When you “hold” a list of layers, highlighting is
removed from the names, so “held” selections appear in the list with an
asterisk before the name.  You can “hold” multiple selections.  Use
Release Selection to remove one selection from “hold” status and use
Release All to remove multiple layer selections.

Select All, Clear All
Use Select All to select all names in the list or Clear All to clear the list.
Use LayerWalk’s Select All feature to quickly turn on all layers in a
drawing, even if the layers selected are Frozen!  

Invert Selection
The Invert Selection option highlights (and displays in the drawing) all layers from the list previously not
highlighted and clears (and does not display in the drawing) those names previously shown.  

Select Unreferenced
The Select Unreferenced feature highlights any unreferenced layers in the drawing (layers that contain no
geometry).  Using Select Unreferenced is a quick way to locate unused layers so you can then use the Purge
button to remove those layer names from the drawing.

Save Layer State
The Save Layer State feature enables you to give a name to the high-
lighted layer group for future use.  A Layer State is a particular layer
visibility setting saved with a name.  For example, if you use LayerWalk
to specify a set of layers for viewing, but expect to view this specific
layer set again sometime in the future, Save the layer state.  In this way
you can Restore the layer state by name in the future rather than having
to select that specific set of layers one by one in the LayerWalk dialog
box.  Named layer states are available in the Express tool Layer
Manager (but are not available in the State Manager from the Layer
Properties Manager).  See previous discussion, “Layer Manager,” for
more information.  Express tool layer states are similar to layer states
available in the Layer Properties Manager discussed in Chapter 11.

Figure 47-21

Figure 47-22



Batch Plot Utility and Express Tools 15Chapter Forty Seven

Copyright 2004 The McGraw-Hill Companies.  All rights reserved.

This utility Freezes the layer(s) of the selected object(s).  More than one object (layer) can be selected for
Freezing with this command, but you select only one object at a time, then the prompt repeats.  You
cannot Freeze the current layer.  AutoCAD gives the following prompt:

Command:  layfrz
Select an object on the layer to be frozen or [Options/Undo]:  PICK
Layer TEXT has been frozen.
Select an object on the layer to be frozen or [Options/Undo]:  PICK
Layer GEOMETRY has been frozen.
Select an object on the layer to be frozen or [Options/Undo]:  Enter
Command:

You can use Undo to undo the last layer (object) selected.  Type O for Options, which issues the following
prompt:

Select an object on the layer to be frozen or [Options/Undo]: o
Enter an option [Entity level nesting/No nesting]<Block level nesting>:

With the No Nesting option, only layers in the current drawing (not Xref layers or nested Block layers) are
Frozen.  Entity level nesting and Block level nesting automatically Freeze Xrefs or Blocks down to the level of
the selected object (Block or Xref).

Use Layfrz to freeze one viewport of a multi-viewport layout.

LAYFRZ COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Freeze LAYFRZ … … … …

Inspect
Select Inspect to open the Inspect dialog box (Fig. 47-23).  This
utility displays the number of layers in the drawing, the number
of layers selected (if any), and the number of objects on the
selected layers.

Copy Filter, Save Current Filter, Delete Current Filter
Use the Copy Filter, Save Current Filter, Delete Current Filter func-
tions to capture and discard layer filter names.  Remember that
filters are temporary (useful only during the current LayerWalk
session) unless saved (see previous discussion, “Layer name edit box and Filter checkbox”).  To save a
filter for use in subsequent LayerWalk sessions (after closing the LayerWalk dialog box), create a filter by
entering a layer name string in the edit box (see previous Figure 47-20), then select Save Current Filter
from the shortcut menu.  Or, use Copy Filter if a single layer name has been highlighted and you want to
save the name as a filter.  The named filter then appears in the drop-down list whenever LayerWalk is
used again for the drawing.  The filter is saved regardless of the setting for Restore on Exit.  The LayerWalk
filters are not available as named layer filters from the Layer Properties Manager.

Figure 47-23
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Use this command to Thaw all layers in the drawing.  Layers that are Frozen and Off are only Thawed by
this command so they still remain invisible until turned On:

Command:  laythw
All layers have been thawed.
Command:

LAYTHW

LAYOFF

LAYON

Layoff is used to turn Off the layer(s) of the selected object(s).  Multiple objects can be selected (one at a
time) to turn off their layers.  The Options are the same as those for Layfrz:

Command: layoff
Select an object on the layer to be frozen or [Options/Undo]:  PICK
Layer ASESMP} 1-WALL has been turned off.
Select an object on the layer to be frozen or [Options/Undo]:  Enter
Command:

This command is a quick way to turn all layers on.  Layers that are Frozen are not affected; only layers
that are Off can be turned On with this command:

Command: layon
Warning: layer 0 is frozen.  Will not display until thawed.
All layers have been turned on.
Command:

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Off LAYOFF … … … …

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Turn All Layers On LAYON … … … …

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Thaw All Layers LAYTHW … … … …



Batch Plot Utility and Express Tools 17Chapter Forty Seven

Copyright 2004 The McGraw-Hill Companies.  All rights reserved.

Laylck locks the layers of selected objects. There are no options for this command. If objects are selected that
are part of an Xref or Block, the layer that was current when the Xref or Block was Attached or Inserted is locked.

Command:  laylck
Select an object on the layer to be locked:  PICK
Layer TEXT has been locked.

LAYLCK

LAYULK

Layulk has the opposite function of Laylck; that is, it unlocks the layers of selected objects.  If the selected
objects are part of an Xref or Block, the layer that was current when the Xref or Block was Attached or
Inserted is unlocked.  There are no options for this command.

Command:  layulk
Select an object on the layer to be unlocked:  PICK
Layer TEXT has been unlocked.
Command:

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Lock LAYLCK … … … …

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Unlock LAYULK … … … …

LAYVPI COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Isolate Layer to 

Current Viewport LAYVPI … … … …

This feature is intended to be used to freeze layers within viewports.  Layvpi freezes specific layers in all
viewports but the current one.  You identify the layer(s) you want to freeze by selecting any object on the
desired layer.  Make sure you select the objects from within the layout in which you do not want the
layer(s) frozen.  

Command: layvpi
Select an object on the layer to be Isolated in viewport or [Options/Undo]:   PICK
Layer A-FURN-P-SEAT has been frozen in all viewports but the current one.

When you select an object, its layer is immediately frozen in all other viewports.  The prompt repeats so
you can continually select objects (on layers to freeze).  If you type O for Options, the following prompt
appears:

Select an option [Layouts/Selection]:
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Laymrg combines selected layers with any other layer.  Objects on the layers to merge are moved to the
target layer, then the merged layer names are deleted.  For example, merging layers LAYER1 and
LAYER2 to layer 0 would move the related objects to layer 0 and delete layers LAYER1 and LAYER2.

Command:  laymrg
Select object on layer to merge or [Type-it/Undo]: PICK
Selected layers: Layer2
Select object on layer to merge or [Type-it/Undo] <done>: PICK
Selected layers: Layer1,Layer2
Select object on layer to merge or [Type-it/Undo] <done>: Enter
Select object on target layer or [Type-it]: PICK
******** WARNING ********
You are about to permanently merge the following layers into layer 0:

Layer1
Layer2

Do you wish to continue? [Yes/No] <No>: y
Merging layer Layer1 into layer 0.
Merging layer Layer2 into layer 0.
All entities which were on layer Layer1 have been moved to layer 0.
All entities which were on layer Layer2 have been moved to layer 0.
Deleting layer “Layer1”.
Deleting layer “Layer2”.
2 layers deleted.
Command:

LAYMRG COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Merge LAYMRG … … … …

The Selection option here is the same as that found in Layfrz which allows you to determine the level of
freezing for nested Blocks or Xrefs (see previous discussion under “Layfrz”).  

Normally using Layvpi affects viewports only in the current layout.  If you want to have layers frozen for
all layouts, enter L for Layouts at the previous prompt to choose from the following:

Isolate layers in [All layouts/Current layout] <Current>:

The All layouts option specifies that the selected layer is frozen in all layouts.  In other words, with this
option, selecting an object on a layer in a viewport not only freezes that layer for all other viewports in
that layout, but it also freezes the layer in all other viewports in all the layouts in that drawing.
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Laydel deletes all objects on a selected layer, then deletes the layer (name).  For example, selecting an
object on LAYER1 would cause Laydel to delete LAYER1 and all objects residing on that layer.

Command: laydel
Select object on layer to delete or [Type-it/Undo]: PICK
Selected layers: Layer1
Select object on layer to delete or [Type-it/Undo] <done>: Enter
******** WARNING ********
You are about to permanently delete layer Layer1 from this drawing.
Do you wish to continue? [Yes/No] <No>: y
Deleting layer “Layer1”.
1 layer deleted. 
Command:

LAYDEL COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Layers>
Layer Delete LAYDEL … … … …

Express Block Tools Commands

In AutoCAD 2004, these commands are grouped in the ET: Blocks toolbar and in the Blocks cascading
menu (under the Express pull-down menu).

NCOPY COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Blocks>
Copy Nested Entities NCOPY … … … …

Ncopy allows you to copy objects that are nested within Xrefs or Blocks.  With built-in AutoCAD com-
mands this is possible to do for Xrefs (using Xbind), but the process is more complex than Ncopy.  Ncopy
allows you to select any object within an Xref or Block to use for copying.  Ncopy operates similarly to the
Copy command:

Command:  ncopy
Select nested objects to copy:  PICK
Select nested objects to copy:  Enter
Select objects: Specify base point or displacement, or [Multiple]: PICK
Specify second point of displacement or <use first point as displacement>: Enter
Command:
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Btrim allows you to trim objects using nested Block or Xref objects as cutting edges.  The command is
simple to use since it operates identically to the Trim command.  If you select an object within a clipped
Xref, the entire object (outside the clipping boundary) is highlighted.

Command: btrim
Select cutting edges:  PICK
Select cutting edges:  Enter
Select objects:
Select object to trim or shift-select to extend or [Project/Edge/Undo]: PICK
Select object to trim or shift-select to extend or [Project/Edge/Undo]: Enter
Command:

Btrim has the same options as Trim, and uses the same method to implement Extend or Trim by holding
down the Shift key when selecting objects (see PROJMODE and EDGEMODE, Chapter 9).

BTRIM COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Blocks>
Trim to Block Entities BTRIM … … … …

XLIST COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Blocks>
List Xref/Block Entities XLIST … … … …

Bextend allows you to extend objects using nested Block or Xref objects as boundary edges.  This utility
(like the Btrim utility) is similar to the built-in AutoCAD counterpart but with the added capability of
extending objects to Block and Xref objects.  Bextend operates identically to the Extend command:

Command:  bextend
Select edges for extend:  PICK
Select edges for extend:  Enter
Select objects:
Select object to extend or shift-select to trim or [Project/Edge/Undo]:  PICK
Select object to extend or shift-select to trim or [Project/Edge/Undo]: Enter
Command:

The Xlist command displays properties of objects that are nested in Xrefs or Blocks.  This is helpful since
the List command reports information about only the top level object (Xref or Block), not information on
nested objects.  Using Xlist produces the following prompt:

BEXTEND COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Blocks>
Extend to Block Entities BEXTEND … … … …
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Command:  xlist
Select nested xref or block object to list:  PICK

After selecting an object within an Xref or Block, Xlist produces the
Xref/Block Nested Object List dialog box (Fig. 47-24).  This dialog box
lists properties of the selected Block or Xref.

BURST COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Modify>
Explode Attributes to text BURST … … … …

CLIPIT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Blocks>
Extended Clip CLIPIT … … … …

Figure 47-24

AutoCAD has the unique feature of clipping Xrefed drawings by specifying a polygonal or rectangular
Pline (no arc segments) as the clipping boundary.  Clipit extends that capability by allowing you to use an
existing Circle, Arc, Pline, Ellipse, or text as a clipping edge for an Xref, Block, or Wipeout (see Wipeout):

Command: clipit
Pick a POLYLINE, CIRCLE, ARC, ELLIPSE, or TEXT object for clipping edge...
Select objects: PICK
Command:
Pick an IMAGE, a WIPEOUT, or an XREF/BLOCK to clip...
Select objects: PICK
Command:
Enter maximum allowable error distance for resolution of arc segments <0.0200>: Enter or (value)
Command:

Use Burst with attributed text (text combined with a Block) like you would use Explode with an
unattributed Block.  Burst actually explodes text attributes but converts the attributes to Text objects.
Normally, if you select attributes to Explode, the Block is exploded and the text is changed back to text,
indicating the original attribute definitions—that is, tags, values, and prompts.  (See Chapter 22, Block
Attributes.)  Using Burst may cause the newly created Text objects to be misaligned from their previous
orientation.

Command:  burst
Select objects:  PICK
Select objects:  Enter

Command:
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AutoCAD “shapes” are files containing alpha-numeric code that defines “strokes.”  The “strokes” can
“draw” shapes that can be geometry or characters of an alphabet.  Shp2blk converts AutoCAD “shapes”
into Blocks.

Before using Shp2blk, you must have a shape object placed in the drawing.  Once you have placed a
shape in a drawing (using the Shape command), use Shp2blk to convert the shape into a Block.  Follow this
prompt sequence:

Command: shp2blk
Select shape entity to convert:  PICK
Select objects:  Enter
Enter the name of the block to create <CHKARO>:  Enter
The shape CHKARO has been replaced with block CHKARO.

Keep in mind with the Express Tools you can easily create shape files from existing geometry.  Use
Makeshp (Express/Tools/Make Shape) to create a shape file from existing geometry you select.  (See
“Express Tools, Tools Commands.”)

SHP2BLK COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Blocks>
Convert Shape to Block SHP2BLK … … … …

ATTOUT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Blocks>
Export Attribute 

Information ATTOUT … … … …

This feature extracts attributes from one or more Blocks.  Attout creates an editable, tab-delimited .TXT
file from any attributed Blocks you select.  The file that is created contains the block-specific handle infor-
mation (unique to the drawing in which it was created).  This procedure is similar to AutoCAD’s Attext
command but does not require the use of an attribute template file (.TXT).

Command: attout
Initializing...
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects:  Enter
Output file: “C:\Dwgs\RmNumb.txt” created.

Note that you can select more than one Block during the command.
You can select either the block geometry or the attributes.

Figure 47-25 is an example of the resulting .TXT file, viewed using
Windows Notepad.  The attribute tag headers and the values for
each block selected are shown.  The resulting .TXT file can be

Figure 47-25
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edited, then re-assigned to the drawing using the Attin Express Tool (see next).

NOTE:  Do not change the column alignment of the .TXT file created from Attout.  Since this file is a tab-
delimited file, edits to the column alignment may produce unexpected results if you use Attin.

ATTIN COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Blocks>
Import Attribute 

Information ATTIN … … … …

Attin converts an attribute extract file back to attributes in a drawing.  This feature works well with
extract files created with Attout or extract files in the same format (.TXT files that contain block handle-
specific information).  This feature is useful if you use Attout, then edit the resulting .TXT file, then use
Attin in order to reassign new attribute data to the same blocks in the same drawing.  

Invoke the command, then select the desired .TXT file in the Enter input
filename dialog box, then select Open.  If AutoCAD finds the block name
and handle information in the drawing that is referenced in the .TXT file,
the new attribute information is inserted and the command ends.

If the edits made to the .TXT file do not result in a match (do not find the
specific Blocks based on the handle information), an ATTIN warning box
appears (Fig. 47-26).  If you choose Yes to assign the data interactively, you
are prompted to select the blocks for the attribute assignment.

Figure 47-26

BLOCKTOXREF

The Blocktoxref utility does not convert Blocks in the current drawing to Xrefs, but it allows you to replace
Blocks defined in the drawing with existing drawings that can be selected as Xref attachments.

If changes to a Block in a drawing are frequent, you may want to
consider converting all Block references to Xref attachments.  This
enables you to make one change in the externally referenced file,
then all instances of the Xref will reflect the change in the draw-
ings to which it is attached.  

Prior to beginning this routine, you must have a .DWG file avail-
able to select as the Xref.  When you invoke Blocktoxref, the
BLOCKTOXREF dialog box appears (Fig. 47-27) listing the exist-
ing blocks in the drawing. Choose the Block name you want to
replace, then select OK.  From the Select an xref file dialog box (not
shown), choose the Xref you want to swap for the Block, then
choose Open.

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Blocks>
Convert Block to Xref BLOCKTOREF … … … …

Figure 47-27
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Next, the following prompt appears regarding purging the block being converted. 

Purge unreferenced items when finished? <Y>:
10 block inserts replaced with xref: C:\Dwgs\D36-Tag.dwg
Results may not be apparent until next regen.

If you will no longer need that Block, press Enter to accept the default of <Y> and that block will no
longer be defined in the drawing’s block definition table or available from the Insert dialog box.

Blockreplace allows you to replace all insertions of a Block in a drawing with another Block from the
drawing.  The new Block must be contained in the current drawing before you launch Blockreplace. 

When you begin Blockreplace, the BLOCKREPLACE dialog box
appears (Fig. 47-28).  The list includes all the existing blocks in
the drawing.  Notice the prompt above the list of block names
stating, “Select the block to be replaced.”  Select the block to
replace, then select OK.  In the next BLOCKREPLACE dialog
box (not shown), the prompt asks you to “Select a block to
replace …” and displays the same list of available blocks in the
drawing.  Select the desired Block to use as the replacement,
then OK.  Before making the replacement, the following prompt
appears asking if you want to Purge the Block(s) that are no
longer used.

Purge unreferenced items when finished? <Y>:
Purging...
No unreferenced linetypes found.
No unreferenced linetypes found.
done.
10 blocks replaced.
Results may not be apparent until next regen.

Express Text Tools Commands

Several outstanding text utilities are included in this set.  For applications that insert and manipulate 
text, these commands are truly an express.  Some of the functions of these commands can be accom-
plished otherwise only by writing custom AutoLISP routines, not by using standard AutoCAD com-
mands.

BLOCKREPLACE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Blocks>
Replace block with 

another block BLOCKTOREPLACE … … … …

Figure 47-28
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Rtext is a streamlined method for importing external text.  The text to import can be from an external file
or can be created “on the fly” using the Diesel option.  The File option produces the Select File dialog box
for you to select a .TXT file for importation.  The text is drawn in AutoCAD based on the current settings
for Style, Height, and Rotation.

Command: rtext
Initializing...
Current settings: Style=Standard  Height=0.5000  Rotation=0
Enter an option [Style/Height/Rotation/File/Diesel] <File>:

When the text is imported into AutoCAD, it is listed as an Rtext object and cannot be edited unless
exploded.  Using Explode on Rtext converts the text to an Mtext object.

RTEXT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Text>
Remote Text RTEXT … … … …

TEXTFIT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Text>
Text Fit TEXTFIT … … … …

Textfit fits text between two specified points.  Using this command gives the same results as using the Fit
option of text alignment; however, this Express command acts on existing text:

Command:  textfit
Select Text to stretch or shrink:  PICK
Specify endpoint or [Start point]:  PICK
Command:

Using the default option you need to PICK only the new ending point and the line of text is changed
using the existing start point but specifying a new endpoint.  You can also change the start point and
endpoint, as shown below:

Command:  textfit
Select Text to stretch or shrink: PICK
Specify endpoint or [Start point]: s
Specify new starting point:  PICK
ending point: PICK
Command:
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When text and other objects are drawn “on top of” each other (so
they occupy the same space), you can use Textmask to make the text
appear “in front of” other objects by “masking” the other objects.  For
example, using Textmask creates text that masks other drawing objects
as shown in Figure 47-29.  Use the following command syntax:

Command: textmask
Initializing...
Current settings: Offset factor = 0.3500, Mask type = Wipeout
Select text objects to mask or [Masktype/Offset]: PICK
1 found
Current settings: Offset factor = 0.3500, Mask type = Wipeout
Select text objects to mask or [Masktype/Offset]: Enter
Masking text with a Wipeout  Wipeout created.
1 text items have been masked with a Wipeout.
Command:

Offset factor is the distance around the text for the imaginary box that is used for “masking” (trimming)
the objects behind the text.

Select text objects to mask or [Masktype/Offset]: o
Mask offset currently set to 0.3500
Enter offset factor relative to text height <0.3500>: (value)

The Masktype option allows for three types of masking.  A Wipeout obscures the background objects completely.
A 3dface mask does not mask the background objects until a Hide is performed.  The Solid option allows
you to select a solid color from the standard Color dialog box to use for obscuring the background objects.

Select text objects to mask or [Masktype/Offset]: m
Mask type currently set to Wipeout
Specify entity type to use for mask [Wipeout/3dface/Solid] <Wipeout>: (option)

TEXTMASK

Figure 47-29

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Text>
Text Mask TEXTMASK … … … …

TEXTUNMASK COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Text>
Unmask Text TEXTUNMASK … … … …

Use Textunmask to remove the mask (wipeout, 3dface, or solid color) from text that a Textmask was previ-
ously applied to.

Command: textunmask
Select text or MText object from which mask is to be removed.
Select objects: PICK
Select objects: Enter
Removed mask from one text object.
Command:
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Textexp explodes text.  The resulting objects are Plines.  As
you probably know, a line or paragraph of text is one object;
therefore, without this command you cannot explode text.
Exploded text is helpful if you need to alter or manipulate
the individual text characters.  For example, to convert text
into 3D solids, use Textexp, convert each letter to a Region,
then Extrude the text (Fig. 47-30):

Command:  txtexp
Select text to be EXPLODED:
Select objects:  PICK
Select objects:  Enter
1 found.
1 text object(s) have been exploded to lines.
The line objects have been placed on layer 0.
Command:

Use Txt2mtxt to convert text created with the Text or Dtext command to an Mtext object.

Command: txt2mtxt
Initializing..._TXT2MTXT
Select text objects, or [Options]<Options>: PICK
Select objects: PICK
Select objects: PICK
Select objects: Enter
2 Text objects removed, 1 MText object added.
Command: 

When the conversion is complete, no visible change may be apparent
depending on the options you used; however, the new Mtext object can
be edited using the typical Mtext editing methods (see Chapter 18 for
more information on editing Mtext).

Pressing Enter or entering O for Options at the first prompt (before
selecting text to convert) produces the Text to Mtext Options dialog box
(Fig. 47-31).  Here you can select from the following options.

Figure 47-30

TXTEXP COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Text>
Explode Text TXTEXP … … … …

TXT2MTXT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Text>
Convert Text to Mtext TXT2MTXT … … … …

Figure 47-31
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Text Ordering
The Text Ordering option you select in this dialog box is important only when converting multiple text
objects at one time with the Txt2mtxt command.  Only one of the two methods can be used at a time.

Sort top-down
The Sort top-down option keeps the lines of Text or Dtext in the same
order after conversion.  You can select the desired lines of Text or
Dtext by any method or in any order.  Figure 47-32 displays how
four lines of Dtext would be converted with the Sort top-down option.
Note that before and after conversion the lines of text appear the
same.

Selection set order
With this option, you must select the text objects to convert in the
order you want the text to appear after conversion.  Therefore, you
should select individual lines of text using the pickbox rather than
using a window method.  Figure 47-33 displays how the four lines of
Dtext would appear after conversion using this option and having
seleced the lines of text to convert (in Figure 47-32) from bottom to
top.

Create word-wrap MText
If the Create word-wrap MText box is checked, Txt2mtxt creates a
single paragraph of Mtext from the selected text objects and word-
wraps the resulting Mtext to the width of the longest (original) text
string in the selection.  Figure 47-34 shows the four lines of text con-
verted (from Figure 47-32) using the word-wrap option but not
changing the order.  Note that the resulting paragraph, in this case,
is confusing to read after word-wrapping since the next character
(“1.”) from the second line wraps up to the first, and so on, based on
the width of the paragraph (text boundary is shown highlighted).
To maintain the same line breaks as the original Dtext objects, don’t
check the Create word-wrap Mtext box.

There is no other easy method to use in AutoCAD to create text along an arc. The built-in AutoCAD com-
mands allow creation of a line of text only along a straight line. With this command, you can “attach” text
to an existing Arc (Fig. 47-35, on the next page). You can use the same command to edit existing
ArcAlignedText objects, as noted by the prompt:

Figure 47-32

Figure 47-33

Figure 47-34

ARCTEXT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Text>
Arc Aligned Text ARCTEXT … … … …
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Command:  arctext
Select an Arc or an ArcAlignedText:  PICK (existing Arc or existing
ArcAlignedText)

After selecting an arc to use for text alignment or selecting
an existing ArcAlignedText object, AutoCAD produces the
ArcAlignedText Workshop dialog box (Fig. 47-36).  Here you
can control the typical text features (style, font, height,
width factor, etc.) as well as many special features.

The following options are available in the ArcAlignedText
Workshop dialog box.

Reverse Text
This option reverses the text so it reads backwards.

Alignment
Left, Right, Fit, and Center methods can be used.  If Fit is
not selected, you can specify the Offset from left and Offset from right.

Position
The text can be created on the Convex or Concave side of the arc.  You can also set a value for Offset from arc.

Outward from the center/Inward to the center
This controls which direction the “top” of the letters point.  Using Figure 47-35 as an example, if Inward
to the center were selected, the top of the letters would point downward resulting in upside-down text.

Typeface
Bold, Italic, and Underline can be selected.

Other Options
Other typical text options are available, such as text Height, Width factor, Style, and font file.

Existing ArcAlignedText objects can be modified with grips but keep the concentric orientation with the
aligned arc.

Figure 47-36

Figure 47-35

Tjust changes the insertion point for existing text created with Text, Dtext, or Mtext.  Tjust does not change
the location of the text, it only moves the insertion point to a new location on the existing text.

TJUST COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Text>
Justify Text TJUST … … … …



Batch Plot Utility and Express Tools 30Chapter Forty Seven

Copyright 2004 The McGraw-Hill Companies. All rights reserved.

Command: tjust
Select objects:   PICK
Select objects:   Enter
Enter new justification...
[Start/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR] <Start>:  Enter option
1 objects modified.

For example, assume you created a line of Dtext using the Center justifica-
tion option (Fig. 47-37).  Note that Dtext has one grip at the lower-left
corner and one at the justification point (center in this case).  The grips can
be used to edit the text or the INSertion Osnap mode can be used to select
the text’s insertion point.  For a review of the various justification options
for text and information about editing text, see Chapter 18, Creating and
Editing Text.

Figure 47-38 displays the same line of Dtext after using Tjust to change
the justification to BR (bottom right).  Note the new grip at the bottom
right instead of at the center. 

Although Tjust can be used on both
Dtext and Mtext objects, its advantage
may be more evident when applied to
Mtext.  If you use Tjust, for example, to
change an Mtext object’s justification
from the default location of TL (top left)
(see Figure 47-39, left) to BR (bottom
right), the text automatically adjusts to
the new justification (see Figure 47-39,
right).  Keep in mind that the text
boundary does not change—the text jus-
tification point is changed within the
existing text boundary.

Figure 47-37

Figure 47-38

Figure 47-39

TORIENT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Text>
Rotate Text TORIENT … … … …

Use the Torient command to adjust the orientation of existing text (including Dtext, Mtext, or attribute
text within Blocks) to a readable position.  Torient cannot be used to edit dimension text or text within tol-
erance dimension feature control frames.  The routine enables you to either specify an absolute rotation
angle for the selected text or use the default option of Most Readable.
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Command: torient
Select TEXT, MTEXT, ATTDEF, or BLOCK inserts w/attributes...
Select objects:  PICK
Select objects:  Enter
New absolute rotation <Most Readable>: 0
5 objects modified.

The New absolute rotation option prompts for a rotation angle
value, then rotates the selected text about its middle justification
point, not its default insertion points.  Enter a value representing
the desired angle for the new orientation. 

The Most Readable option does not rotate the line of text.  This
option only ensures that the text is read from left to right.  For
example, if the text appears somewhat upside down and reads
from right to left (see Figure 47-40, left), the Most Readable option
“flips” the text about its center (see Figure 47-40, right) to read
mostly right to left.

Figure 47-40

Tcircle allows you to create a circle, slot, or box
around existing text objects.  This is a great
command to use for emphasizing specific text such
as part numbers, room names or numbers, and
column or data callouts.  This routine operates with
Dtext, Mtext or Attdef text objects (before creating the
Block) and encloses the selected objects with your
choice of circles, slots, or rectangles.  Figure 47-41
displays slots created with Tcircle.  

Command: tcircle
Select TEXT, MTEXT or ATTDEF objects...
Select objects:  PICK
Select objects:  Enter
Enter distance offset factor <0.35000000>:   Enter
Enclose text with [Circles/Slots/Rectangles]
<Slots>:  Enter or option
Create slots of constant or variable size
[Constant/Variable] <Variable>: Enter or option
Creating Slots...Done.
4 Slots created.

The new objects are drawn on the current layer.  Slots and boxes that are created are actually Plines.  

TCIRCLE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Text>
Enclose Text with Object TCIRCLE … … … …

Figure 47-41
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Distance offset factor
The prompt to Enter distance offset factor enables you to specify a percentage of offset distance for the new
object from the body of the text.  For example, the default of 0.35 makes the offset distance 35% of the
largest text character.  This option is similar to the that found in the Express tools Textmask command.

Constant/Variable
The Constant/Variable option allows you to specify whether you want the same box, circle, or rectangle
size for all the selected text objects or if the new objects should adjust to accommodate the size of the
individual text objects.  With the default option of Variable, the routine automatically adjusts the object
based on the text size and your offset factor (see Figure 47-41).  If you opt for Constant the following
prompt appears:

Create slots of constant or variable size [Constant/Variable] <Variable>: C
Maintain constant slot [Width/Height/Both] <Both>:  Enter
Determining best size...Done.
Creating Slots...Done.
4 Slots created.

Since Tcircle creates new objects around individual text objects, you may want to first convert multiple
lines of Dtext that are to be enclosed to a single Mtext object using Txt2mtxt.

Use Tcount to add a numeric prefix or suffix to existing text.  Tcount does not create new, sequentially
numbered text.  You can, however, overwrite existing text with user-specified sequential numbers.  

Command: tcount
Select objects:  PICK
Select objects:  PICK
Select objects:  PICK
Select objects:  PICK
Select objects:  Enter
Sort selected objects by [X/Y/Select-order] <Select-order>:  Enter
Specify starting number and increment (Start,increment) <1,1>:  100,2
Placement of numbers in text [Overwrite/Prefix/Suffix/Find&replace..] < Prefix>: Enter
4 objects modified.

Select-order
When adding a prefix or suffix to existing text, you can select the text objects in the order you want the
numbers applied, then accept the default Select-order option.  Numbers are applied in the order that
objects were selected.

X/Y
If you are numbering text objects in rows or columns, you can use the X/Y methods.  Using the sort
method of X, the numeric sequencing goes from left to right.  Use the Y sort method to automate the
sequence from top to bottom (actually, negative Y direction).  

TCOUNT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Text>
Automatic Text Numbering TCOUNT … … … …
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Staring number and increment
Accept the “starting number and increment” of
1,1 if you want to begin with number 1 and
increase numbering by 1 with each text object.  You
can instead specify that sequencing begin at any
other number and specify another increment for
counting.  Leading zeros are ignored.  Figure 47-42
displays four existing text objects after a numerical
prefix has been added to each text object using the
command sequence shown previously.  Note the
values entered for Start and increment and the
resulting numbers.

Find&replace
The Find&replace feature operates in the same
manner as other similar routines in which you 
are prompted to enter a search string and all
instances are replaced with the specified method 
of numbering.

Figure 47-42

TCASE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Text>
Change Text Case TCASE … … … …

Tcase provides a utility for changing the case (upper case, lower case, etc.)
of existing text objects.  When you select existing text for this command,
the TCASE – change text case dialog box appears (Fig. 47-43).  Here you can
choose from five different text case formatting options (including the
current case).  The feature selected in the dialog box will apply to all text
selected.  The following options are available.

Sentence case
Use this to capitalize only the first word in a multi-word text string.

lowercase
This option changes all selected text to lower case.

UPPERCASE
Use this option to change all the selected text to upper case.

Title
This Option Capitalizes The First Letter Of Each Word In The Selected Text String As Shown Here.

tOGGLE cASE.
This feature reverses the current case of each letter of the selected text.  This option is useful if the Caps
Lock key on your keyboard is on and you enter lines of text before noticing.

Figure 47-43
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The typical Stretch command requires that you select objects to stretch with one Crossing Window or
Window Polygon.  Any objects that are not within the selection window must be stretched with another
use of the command.  In contrast, Mstretch allows you to create multiple selection windows before
stretching the objects:

Command: mstretch
Define crossing windows or crossing polygons...
Options: Crossing Polygon or Crossing first point
Specify an option [CP/C] <Crossing first point>: PICK
Specify other corner: PICK
Options: Crossing Polygon, Crossing first point or Undo
Specify an option [CP/C/Undo] <Crossing first point>: PICK
Specify other corner: PICK
Options: Crossing Polygon, Crossing first point or Undo
Specify an option [CP/C/Undo] <Crossing first point>: Enter
Done defining windows for stretch...
Specify an option [Remove objects] <Base point>: PICK
Second base point: PICK
Command:

You can use either a crossing window (C option) or a crossing polygon (CP option) to select the object(s)
to stretch.

MSTRETCH

Mocoro allows you to perform a Move, Copy, Rotate, or Scale, or any combination of these operations in
one command.  This utility is especially useful for those who set GRIPS to 0 (off), but occasionally need
these capabilities without using Grips:

MOCORO

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Modify>
Multiple Entity Stretch MSTRETCH … … … …

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Modify>
Move Copy Rotate MOCORO … … … …

Express Standard Tools Commands

The Standard Express toolbar contains a number of commands useful principally for modifying objects.
A few commands are included for drawing and for other utilities.  If you use pull-down menus, these
commands are spread through the Selection Tools, Modify, Draw, and Tools sections of the Express pull-
down menu.



Batch Plot Utility and Express Tools 35Chapter Forty Seven

Copyright 2004 The McGraw-Hill Companies.  All rights reserved.

Command:  mocoro
Select objects:  PICK
Select objects:  Enter
Base point: PICK
[Move/Copy/Rotate/Scale/Base /Undo]<eXit>: m
Second point of displacement: PICK
[Move/Copy/Rotate/Scale/Base /Undo]<eXit>: r
Second point or rotation angle: PICK
[Move/Copy/Rotate/Scale/Baset/Undo]<eXit>: c
Second point of displacement/Undo]<eXit>:  PICK
Second point of displacement/Undo]<eXit>:  Enter
[Move/Copy/Rotate/Scale/Base /Undo]<eXit>:  Enter
Command:

The Superhatch command allows you to hatch an enclosed area, similar to the
Hatch command.  However, with Superhatch you can select an image (.TIF, .TGA,
.BMP, etc.), Block, Xref, or Wipeout object to use as the hatch pattern.  Using the
Superhatch command produces the SuperHatch dialog box (Fig. 47-44).

After you select the appropriate choice to use as a hatch pattern object (Image,
Block, Xref, or Wipeout), another dialog box appears for you to select the desired
file or object, followed by a series of prompts.  For example, after selecting an
image file as the hatch pattern object, the following prompts appear:

Command: superhatch
Insertion point <0,0>: PICK
Base image size: Width: 1.000000, Height: 0.920792, Inches
Specify scale factor <1>: Enter or (value)
Command:
Is the placement of this IMAGE acceptable? [Yes/No] <Yes>: Enter
Selecting visible objects for boundary detection...Done.
Specify an option [Advanced options] <Internal point>: PICK
Specify an option [Advanced options] <Internal point>: Enter
Preparing hatch objects for display...
Done.
Use TFRAMES to toggle object frames on and off.
Command:

Typically you would prefer that the hatch object is smaller than the internal area you select for hatching.
In that case, the hatch object is replicated similar to any other hatch pattern.

SUPERHATCH COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Draw>
Super Hatch… SUPERHATCH … … … …

Figure 47-44
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Tframes is short for “toggle frames.”  Type this command or use the button shown to toggle a “frame” or
outline of the hatched area (hatched with Superhatch) on or off.  Keep in mind that the object(s) used to
define the hatch boundary may obscure the Superhatch frame, so when Tframes is toggled on, it may
appear as if there are two outlines.  This feature can also be used to toggle the visibility of the frame of an
inserted raster image or masked text. 

The Showurls utility is helpful for display-
ing and editing URL links (created with the
Hyperlink or Attachurl command) in the
current drawing.  Showurls produces the
SHOWURLS dialog box that lists all the
URLs in the drawing (Fig. 47-45).

You can easily locate an object with an
attached URL by selecting the Show URL
button.  AutoCAD dismisses the dialog box
temporarily and highlights the drawing
object, then displays the dialog box again
automatically after a second or two.  

Use the Edit option to produce the dialog box shown in
Figure 47-46.  Here you can edit the contents of any
selected URL.  Use this option to change URLs one at a
time.

Selecting the Replace option produces the Replace URL Text
dialog box where you specify a text string to Find What
and Replace What.  This option globally searches and
replaces specified text strings contained in URLs in the
drawing.  This is helpful when a series of URLs in a
drawing reference a web site that has undergone a name change.

Copyright 2004 The McGraw-Hill Companies.  All rights reserved.

TFRAMES COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

… TFRAMES … … … …

SHOWURLS COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
Show URLs… SHOWURLS … … … …

Figure 47-45

Figure 47-46
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This command adds a line to a drawing with a break symbol at
the center of the line or other location you specify.  Break lines
are used for many applications where you do not need to draw
the entire object or length of a series of lines.  For example,
Figure 47-47 shows two break lines added to a drawing of a stair
case, each break line was created using the values given in the
following prompts (Trim was used to trim lines between the two
break lines).

Command: breakline
Block= BRKLINE.DWG, Size= 8’-0”, Extension= 3’-0”
Specify first point for breakline or [Block/Size/Extension]:  PICK
Specify second point for breakline:  PICK
Specify location for break symbol <Midpoint>:  PICK

Use the Size option to specify the width of the break symbol
along the line.  The Extension option specifies the distance
beyond the points you pick as the “first point” and “second
point.”  Typically, you would use an Osnap option to select these two points and Breakline draws a line
between the selected points.  Next, you can specify a point on the line to place the break symbol or use
the default Midpoint option.  If you pick a point, the Nearest and Midpoint Osnap options are turned on. 

The Fast Select command is actually a selection method used
to select multiple objects with one pick rather than having to
select individual objects.  Fast Select allows you to select a
group of objects that are connected (physically touch) by
selecting only one of the objects.  

For example, you can use Fast Select to select an entire group
of tables or both tables and chairs.  Figure 47-48 (left group)
shows how selecting a line normally (without Fast Select) high-
lights only that line.  With Fast Select, selecting the same line
highlights the line and all other objects touching the line (Fig
47-48, center).  

BREAKLINE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Draw>
Break-line Symbol BREAKLINE … … … …

Figure 47-47

FS COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Selection Tools>
Fast Select FS … … … …

Figure 47-48



Batch Plot Utility and Express Tools 38Chapter Forty Seven

Copyright 2004 The McGraw-Hill Companies.  All rights reserved.

Command: ‘fs
Initializing...
Use ‘FSMODE to control chain selection.
FSMODE = OFF
Select touching object: PICK
7 object(s) found.
Exiting Fastsel

The FSMODE variable determines the extent to which the selection is made.  With the FSMODE variable
set to Off, only those items touching the selected object are selected, as shown in Figure 47-48, center.
With the FSMODE variable set to On, a “chain” selection is in effect whereby all connected or touching
objects are selected (Figure 47-48, right). 

The Fast Select method can be initialized transparently at any “Select objects” prompt by preceding the
entry with an apostrophe, as in ‘fs .  When launched directly from the Express, Selection Tools menu, the
command line indicates the FSMODE setting.

NOTE:  Using Fast Select may result in different selection sets based on which object is the primary object
selected, especially when the FSMODE variable is set to Off.

The Multiple Copy command allows you to make multiple copies of selected objects and place the copies
using the Repeat, Divide, and Measure, and Array options.  Using this command and its options is similar
to using Grips with the Copy option where the copies are placed using an auxiliary grid (see Chapter 23,
Grip Editing, for more information).

Using the Multiple Copy express tool with the default option (selecting a “Second point”) is similar to
using the normal Copy command with the Multiple option.  

Command: copym
Select objects: PICK
Select objects:  Enter
Base point: PICK
Second point or [Repeat (last)/Divide/Measure/Array (dynamic)/Undo] <exit>: PICK
Second point or [Repeat (last)/Divide/Measure/Array (dynamic)/Undo] <exit>: PICK
Second point or [Repeat (last)/Divide/Measure/Array (dynamic)/Undo] <exit>:  Enter

COPYM COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Modify>
Multiple Copy COPYM … … … …
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Repeat
Once you place the first
copy, you can use Repeat to
create another copy using
the same displacement
(XY spacing) for the next
copy.  This is similar to
using Grips to make a
copy, then holding down
the Shift key to set up an
auxiliary grid using the
same XY spacing.
However, with Multiple
Copy, simply type R for the
new copy to be made.  In Figure 47-49, after making the first copy of the chair, the Repeat option was
used to make the second copy rather than picking a new “Second point.”  

Divide
The Divide option creates the number of copies you specify along an imaginary line.  The first point of
the line is the previously selected base point, then you are prompted for the “division ending point” and
the number of copies.  

Second point or [Repeat (last)/Divide/Measure/Array (dynamic)/Undo] <exit>: d
Select division ending point: PICK
Number of copies: (Enter value)

Measure
The Measure option is similar to the Divide option, except you are prompted for the “Distance between
copies,” rather than the number of copies.

Array
Use this feature to set up a rectangular array of copies.  You must place each copy individually.  The
copies can be placed on a grid determined by a point you pick in response to the “Pick a corner point to
establish COLUMN and ROW distances” prompt (the first corner is the previously specified base point).
This option is also similar to using Grips with the Copy option and the Shift key to set up an auxiliary
grid.

Second point or [Repeat (last)/Divide/Measure/Array (dynamic)/Undo] <exit>: a
Pick (dynamic)/Measure/Divide <Pick>: Enter
Specify angle <0>: Enter
Pick a corner point to establish COLUMN and ROW distances: PICK
Pick location for array element or <enter> when done: PICK (location for new copy)
Pick location for array element or <enter> when done: PICK (location for new copy)
Pick location for array element or <enter> when done: Enter

Figure 47-49
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Express Layout Tools Commands

This collection of commands is intended for working with layouts.  Some of these commands may be
particularly helpful when working with older drawings that used paper space (created before multiple
layouts were introduced).  These commands all require that you are in a Layout tab prior to initiating the
command.

The Chspace command allows you to transfer selected objects from one space (Paper or Model) to
another.  You can transfer objects from a Model space viewport to the current Layout or from the current
Layout into a specified Model space viewport.  For example, if you want to swap objects between Model
space and Paper space, such as a sheet border, revision block, or a drawing legend, use this tool.  You
must invoke this command when in a Layout.  

Command: chspace
Select objects: PICK
Specify opposite corner: PICK
Select objects:  Enter
Set the TARGET viewport active and press ENTER to continue.  Enter
117 object(s) changed from PAPER space to MODEL space.
Objects were scaled by a factor of 29’-0 7/16” to maintain visual appearance.

When transferred, the objects selected are automatically scaled to appear the same in the destination
space.  For this reason, when transferring from a Model space viewport to the Layout, it is suggested that
you zoom as necessary before invoking Chspace.

CHSPACE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Layout tools>
Change Space CHSPACE … … … …

ALIGNSPACE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Layout tools>
Align Space ALIGNSPACE … … … …

Occasionally you may want to change the display of Model space objects visible in a viewport (in a
Layout) so they align with objects in the current layout.  This command does not move the objects, but
rather pans the drawing (Model space) to the desired alignment point.

Command: alignspace
FIRST alignment point in MODEL space:  PICK
SECOND point in MODEL space or <Return> for none: PICK or Enter
Alignment point in PAPER space:  PICK
Activate the desired viewport to align and press ENTER to continue. Enter
Paper space = Model space

1” = 3’-6 5/8”
Current zoom factor = 0”xp
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After picking the necessary points, Alignspace essentially pans the display of the drawing in the viewport
so that the points specified in Model space are aligned with the points picked in the layout.  Although
the drawing is panned, the zoom factor of the viewport remains unchanged.

VPSYNC COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Layout tools>
Synchronize Viewports VPSYNC … … … …

This express tool scales (synchronizes) the display of objects in multiple viewports to the scale and
display of a selected “master” viewport.  Vpsync automatically changes the zoom ratio of the viewports
to match that of the master viewport, then displays an appropriate area of the drawing (pans the
drawing) in each viewport based on the area displayed in the master viewport.  Although you are not
specifically prompted, you must select the “master” viewport (the viewport object in the layout) in
response to the first “Select objects” prompt. 

Command: vpsync
Select objects:  PICK (Select the master viewport)
Select viewports to be aligned to master viewport.
Select objects:   PICK
Select objects:   PICK
Select objects:   PICK
Select objects: Enter
Paper space = Model space

1” = 29’-7 3/64”
Current zoom factor = 0”xp
Paper space = Model space

1” = 29’-7 3/64”
Current zoom factor = 0”xp
Paper space = Model space

1” = 29’-7 3/64”
Current zoom factor = 0”xp

For example in Figure 47-50, each of four view-
ports displays the model geometry at a different
scale (zoom ratio).  Use Vpsync to scale the
display of the geometry in each viewport to that
of the upper-left viewport.

Figure 47-50
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First, select the upper-left viewport as the
“master” viewport.  Next, select the remaining
three viewports.  Figure 47-51 illustrates how the
display (zoom scale and area of the drawing) in
those viewports was synchronized with the
master viewport. 

Note: Do not press Enter after selecting the
master viewport as the command automatically
moves on to the next prompt for the viewports to
be aligned.

Figure 47-51

VPSCALE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Layout tools>
List Viewport Scale VPSCALE … … … …

Vpscale lists the zoom ratio of Paper space to Model space for a particular viewport.  This command is
helpful when you have zoomed the drawing in a viewport to display the desired area, but you want to
ensure you plot the drawing (technically, the viewport scale) to a standard scale.  Use Vpscale to return
the scale of the viewport in ratio format of Paper space to Model space units (PS:MS), then set the view-
port scale (using the drop-down list in the Viewports toolbar) to standard scale close to the reported ratio.

Command: vpscale
Initializing...
Select edge of viewport.
Select objects: PICK
Command: vpscale
PS:MS == 1:353.280001
Viewport Scale: 9/256” = 1’-0”

In the above example, the ‘Viewport Scale’ value is close to 10/250 or 1/25.   The closest common archi-
tectural scale would be 1/32”=1’.  The closest common engineering scale may be 1:250 or 1:500.
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This command merges the contents of multiple layouts into a single layout.  The entire contents of the
selected layouts are “moved,” including the viewport objects, the drawing (model) area displayed in the
viewports, and any paper space geometry in the layouts.  Specifications for device drivers, sheet sizes,
and plotting parameters are not copied to the new layout.

Because this command “sweeps” all layout contents from the selected layouts to the target layout, it
should be used with caution.  It is recommended to save the drawing to another name before using this
command.  Also, you should create a new layout which will eventually be used as the destination layout.
(No spaces are allowed in the destination layout name.)

Begin the Layoutmerge command to produce the LAYOUT-
MERGE dialog box (Fig. 47-52).  Here you should select all the
layout(s) to be merged to the destination layout.  Notice that
the text above the layout listing states to “Select layout(s) to
merge.”  You should use the Shift key or Ctrl key to select
more than one layout to merge as shown in Figure 47-52, then
select OK.

The next dialog box that appears is also named LAYOUT-
MERGE (not shown), but this dialog box prompts you to
“Specify (a) destination layout.”  Select the layout you created
as the layout you want to merge to, then select OK.  The fol-
lowing prompt appears.

Command: layoutmerge
Delete unused layouts? <Y>:

Answering Y causes the selected (merged) layouts to be deleted.  If you elect not to “delete unused
layouts,” the layouts and their contents will be retained.  After entering your response, AutoCAD contin-
ues with the merging process. At the completion of the procedure, the layout selected to be the merge
layout is set to be the active layout. 

Restoring cached viewports - Regenerating layout.
Regenerating layout.
Regenerating model - caching viewports.
Regenerating model.
2 layouts merged.

After using this command, you should use Page Setup to specify new plotting or printing parameters 
for the new layout since the contents of the new layout will most likely require new device or sheet size
settings.

LAYOUTMERGE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Layout tools>
Merge Layout LAYOUTMERGE … … … …

Figure 47-52



QLATTACH COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Dimension>
Leader Tools>
Attach Leader to… QLATTACH … … … …

QLDETACHSET COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express Tools
Dimension>
Leader Tools>
Detach Leaders 

from Annotation QLDETACHSET … … … …

QLATTACHSET COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express Tools
Dimension>
Leader Tools>
Global Attach Leader 

to Annotation QLATTACHSET … … … …
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Express Dimension Commands

Commands in this section are found in the Dimension group of the Express pull-down menu.  The first
three, Qlattach, Qldetachset, and Qlattacheset, are in a separate menu of Leader Tools.  The remaining items
are listed in the Dimension group.

Use Qlattach to attach an existing leader to an annotation (Mtext, Block, or Tolerance objects).  Qleader auto-
matically changes the endpoint of the leader and/or moves the annotation to align and attach to the top
of the top line of text.  If the annotation object is later moved, the leader stays attached.

Command:  qlattach
Select Leader:  PICK
Select Annotation:  PICK
Command:

The Qldetachset command can be used to “break” the connection between a leader and the related text.
When Qldetachset is used, the leader and related text become independent objects and can be modified
separately.  In addition, the leader line no longer contains a “hook” (short horizontal segment) aligned
with the text object.  Qldetachset operates for text/leader combinations created with the Leader, Qleader, or
Qlattach commands.

This command is intended to attach previously created leaders to existing Mtext, Tolerance, or Block
objects.  Qldetachset is similar to the Qlattach command, with the exception that multiple annotation or
leader objects  can be selected in response to the “Select objects:” prompt.  
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DIMEX

DIMIM

Use Dimim to import previously exported dimension styles (see Dimex).
Dimim invokes the Dimension Style Import dialog box (Fig. 47-54).  Use
Browse… to locate the desired *.DIM file.

This is a very useful utility for exporting dimension styles from the current
drawing to a file for importation into another drawing with Dimim
(dimension import).  Dimex produces the Dimension Style Export dialog box
(Fig. 47-53).  Select a dimension style to export, then select OK.  The
dimension style is saved to a file with a .DIM file extension.

Figure 47-53

Figure 47-54

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Dimension>
Dimstyle Export… DIMEX … … … …

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Dimension>
Dimstyle Import… DIMIM … … … …

DIMREASSOC

This feature does not turn nonassociative dimensions into associative dimensions as the name might imply.
Instead, this command is intended to reset the true associative value of an associative dimension whose
value has been modified to something other than the original value.  For example, assume Ddedit was used
to change a dimension value from the actual AutoCAD-measured value to other text that was entered (in
place of the “<>” symbol).  You could then use Dimreassoc to reclaim the true AutoCAD-measured value.

Command: dimreassoc
Select objects: PICK
Select objects: PICK
Select objects:  Enter
2 objects modified.

To learn more about editing dimensions, refer to Chapter 28, Dimensioning.

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Dimension>
Reset Dim Text Value DIMREASSOC … … … …
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Express Selection Tools Commands

The commands in this group include two enhanced routines for selecting objects.  The Fast Select utility is
found among the Express Tools Standard toolbar group (discussed previously).  The Getsel feature is
command line driven and is similar in operation to Quick Select (Qselect).

GETSEL COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Selection Tools>
Get Selection Set GETSEL … … … …

Getsel allows you to PICK specific objects by object type or by layer and use them as the current selection
set.  You can select the desired layer (or all layers) or the desired object type (or all object types).  This
utility is a fast alternative to using the Filter command to locate and find specific object types.  Getsel
issues the following prompt:

Command: getsel
Select an object on the Source layer <*>: PICK
Select an object of the Type you want <*>: PICK
Collecting all LWPOLYLINE objects on layer GEOMETRY...
7 objects have been placed in the active selection set.
Command:

Express Modify Tools Commands

The Express Modify group has a variety of tools that either automate common procedures or enable you
to more efficiently edit your drawing.  Only the Exoffset command is explained here, however, since the
other commands in the Modify group also appear in the ET: Standard toolbar or other locations previ-
ously discussed.

EXOFFSET COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Modify>
Extended Offset EXOFFSET … … … …

The Extended Offset command provides a collection of offset-related features and could, therefore, be con-
sidered an “extension” of the Offset command.  For a review of the Offset command, refer to Chapter 9,
Modify Commands I.

The Extended Offset feature begins with prompt similar to the Offset command, but also includes a line of
information listing the current settings and access to other options.  

Command: exoffset
Settings: Distance = Through,  Layer = SOURCE, Gaptype = Normal
Specify offset distance or [Through] <Through>: (value) or Enter
Select object(s) to offset or [Options/Undo]:
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Changes to the Distance, Layer, and Gaptype settings are done using the Options selection.  When you type
O for Options the following prompt appears.

Specify an option to set [Distance/Layer/Gaptype]:

Distance
The Distance option enables you to specify the distance for the offset.  This value can also be specified at
the opening prompt of the command.  

Layer
Type L for the Layer option and you can choose between the Source or Current layer as the target location
for the offset objects.  By default, AutoCAD places the offset objects on the same layer as the selected
(Source) object.

Gaptype
This option is useful when offsetting Plines.  Gaptype options are Normal, Fillet, and Chamfer.  Your selection
sets the OFFSETGAPTYPE system variable (refer to Appendix A, System Variables, for more information).

Specify an option to set [Distance/Layer/Gaptype]: g
Specify offset behavior for plines [Normal/Fillet/Chamfer] <Normal>:

After setting the desired values for the options, press Enter to return to the initial prompt and to select
the object to be offset.  Despite the indication of the prompt, “Select objects(s),” you can select only one
object at a time.

Select object(s) to offset or [Options/Undo]: PICK
1 object(s) found.
Shift+Pick for multiple; Ctrl+Pick to erase source object.
Side to offset or [Multiple/Options/Undo]:

Multiple, Shift+Pick, Ctrl+Pick
Hold down the Shift key when picking the side to offset to make successive offsets using the original dis-
tance for each offset.  The same action can also be accomplished by typing M for the Multiple option.  If
you hold the Ctrl key down when you pick the side to offset, the highlighted source object is erased after
being offset.  Type O for the previously described collection of options (Distance, Layer, and Gaptype). 

Express File Tools Commands

This collection of file-related tools enhances your productivity not only for .DWG files, but also for .BAK,
.PLT, and raster files.  Also included is a tool that enhances the Drawing Properties utility for working
with large projects or implementing consistency among your project files.

MOVEBAK COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
File tools>
Move Backup Files MOVEBAK … … … …

Use this command to redirect the .BAK files to a folder you specify (overriding the folder specified in the
Files tab of the Options dialog box).  When entering the name of the new folder where the .BAK files are to
be saved, be sure to enter the full path name including the drive letter, such as “C:\backup.”    
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Command: movebak
New value for MOVEBAK, or . for none <>: (Enter new location for .bak files)

This setting is valid only for the current AutoCAD session.  When you save any drawing during that
session, you will see the following notice:

Moving BAK file to ‘c:\backup\PROJECT 4.bak’.

When you exit AutoCAD, the location specified for Movebak is “released.”  .BAK files in future AutoCAD
sessions are saved to the folder in which their related .DWG file is saved as specified in the Files tab of
the Options dialog box.  For more information on backup files and settings of the Options dialog box, refer
to Chapter 43, Miscellaneous Commands and Features.

PLT2DWG COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
File tools>
Convert PLT to DWG PLT2DWG … … … …

Use this command to convert a .PLT file to a .DWG file.  .PLT files are created by configuring an HPGL
device, then plotting using the Plot to File option in the Plot dialog box.  Only files created using an
HPGL device driver are supported, whereas files created using an HPGL/2 driver are not supported.
The Draftpro DXL and Draftpro EXL are also not supported.  

When you launch the Plt2dwg command, the Enter the plot file dialog box (not shown) opens, from which
you can choose the .PLT file to convert.  Because .PLT files contain information primarily for pen strokes
and pen settings, the resulting converted drawing contains only 2D geometry.  Some layering and color
information is included.

This command is used to edit an exising raster image inserted in your drawing.  The command launches
a system-supported image editing program such as Microsoft Paintbrush. 

Command: imageedit
Use the IMAGEAPP command to specify a non-system-default editor.
Select objects: PICK

Once you select the image to be edited, the IMAGE EDIT dialog box opens giving the name and location
of the inserted image file.  Choose Open to launch the image editing program.  You can also navigate and
select another image file you may want to use as a replacement.

After editing and saving the image and closing the image editing application, the newly edited image
appears in the drawing.   When saving the edited image file, it is suggested to enter a unique name for
the edited image, otherwise the existing file is overwritten.

IMAGEEDIT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
File tools>
Edit Image IMAGEEDIT … … … …
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If the desired image editing application does not automatically open, type IMAGEAPP at the prompt line
and enter the full path, filename, and extension of the application you want AutoCAD to launch as your
default image-editing application. 

For projects involving many drawings, the Update Drawing Property Data command may be useful for
maintaining the same project information for all drawings in the project.  Using this command, drawing
properties information can be populated to multiple drawings using a properties populate template
(.PRP).  Using this routine avoids having to enter the drawing properties information for each drawing
using the Dwgprops command.  A drawing’s properties appear in the Properties dialog box that appears if
you use the Dwgprops command in AutoCAD or if you use Windows Explorer or My Computer to list a
drawing file’s properties.  For more information on the Dwgprops command, refer to Chapter 2, Working
With Files.

Before populating drawings with the specific information you want, you must have an existing .PRP file
containing the information you want to populate.  AutoCAD provides a default file, TEMPLATE.PRP,
that can be edited and saved under a new name.  You can edit the file using the Propulate command or
using an external text editor.  Begin the Propulate command to use this series of prompts.

Command: Propulate
Default template file: C:\Program Files\AutoCAD 2004\express\template.prp
Enter an option [Active template/Edit template/List/Remove/Update] <Update>:  Enter
Update Drawing Properties information from template
Enter an option [Current drawing/Other drawings] <Current>: Enter
Writing C:\Program Files\AutoCAD 2004\Sample\8th floor.dwg Drawing Properties Info.

Update
The update option allows you to populate drawing properties to the current drawing or directories of
drawings.  Update uses the information supplied from the active template to process the selected
drawing(s).  (Before using Update, specify the active template using the Active Template option.)  Selecting
the Other drawings option allows you to specify a search directory and drawing name.  For example,
entering “C:\projects\proj2*.dwg” causes a search for all drawings whose names start with “proj2”
starting in the “C:\projects” directory.

Active template
Choose an existing .PRP drawing properties template file from the Select Propulate Template File dialog
box.  The default file of template.prp can be opened, then edited and saved under a new name.

List
To view the properties information for the current or other drawings (rather than using the Drawing
Properties window), use the List option to produce a text screen of the properties information.

Remove
Use this option to strip the drawing properties information from the current drawing or from a directory
of drawings.

PROPULATE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
File tools>
Update Drawing 

Property Data PROPULATE … … … …
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Edit template
Use this feature to open the Edit Propulate Template dialog box (Fig. 47-
55).  Here you can add to or modify the fields.  The template can then
be used to Update the drawing properties information for the current
drawing or multiple other drawings.  

Special Insert Variables
You can use special insert commands to extract data (from the draw-
ings that you intend to Propulate) and insert the information into the
Drawing Properties dialog box, therefore listing properties that can be
unique for each drawing.  Three of these variables appear in the
Comments section of Figure 47-55.  The variables are explained here.

@[block.attributeTag] 
This variable extracts the attribute tag value from an attributed block and
inserts it in the specified field.  For example, inserting @[title.drawnby]
in the Author field causes Propulate to search the drawing being pro-
cessed for an attributed block named “title,” extract the value of its
attribute tag “drawnby,” and insert that value in the Author field of the
drawings Drawing Properties dialog box.  Therefore, if common blocks are used across a project it is rela-
tively simple to update a large number of drawings to reflect their specific attribute values.

@[XREFLIST], @[FONTLIST], @[IMAGELIST]
These variables insert a list of the Xrefs, fonts, or images currently attached to the drawing being pro-
cessed.  You can use these variables only in the Comment field.

Two pull-down menus are available at the top of the Edit Propulate Template dialog box:  File and Template.  

File
The File menu enables you to begin with a New template with empty fields, Open and existing .PRP file,
Save the current file or use Save As and give the file a new name.  Unfortunately, the name of the current
.PRP file is not listed in the title bar of the dialog box.

Template
Use the Template pull-down menu to automate the procedure for including information in the Comments
section of the template dialog box.  You can request Xref, Font, Image, or Attribute information from the
processed drawings to be included in the drawing properties information (see “Special Insert
Variables”).  If you want to use the current drawing’s information (previously specified using the
Dwgprops command), select the Fill from Current drawing option.  The Make active template option sets the
template currently being edited to be the default template.  This option is disabled if the edited template
is already the default or if it has not yet been saved to a file name.

Figure 47-55

SAVEALL COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
File tools>
Save All Drawings SAVEALL … … … …

Use this feature to save all the open drawings in the current AutoCAD session, but keep the drawings
open for further editing.  AutoCAD invokes Qsave for previously named drawings, and for those draw-
ings that have yet been named, the Save Drawing As dialog box appears.
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Use this feature to close all open drawings at once.  For those drawings that have not yet been named,
the typical “Save changes to …?” alert dialog box appears.

CLOSEALL COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
File tools>
Close All Drawings CLOSEALL … … … …

QUIT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
File tools>
Quick Exit QUIT … … … …

Use this feature to exit the current AutoCAD session.  If a drawing has not been named, or if you have
modified a drawing since it was last saved, the typical alert dialog box regarding saving changes
appears.  After all drawings have been accounted for, AutoCAD closes.

REVERT COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
File tools>
Revert to Original REVERT … … … …

Revert closes and reopens the current drawing.  This is useful if you want to disregard any changes and
reopen a drawing in its last saved condition.  If you select OK from the “Abandon changes….” alert box
AutoCAD simply re-opens the last-saved version of the drawing.  You can also Cancel the process.

REDIR COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
Path Substitution REDIR … …

The Redir command allows you to substitute any or all hard coded path names for Xrefs, styles, shapes
and images.  Redir operates like a search and replace, so you can specify a new path, substitute a portion
of a path, or even remove path references entirely.  Use the “?” option to list the current paths.

Command: redir
Current REDIRMODE: Styles,Xrefs,Images,Rtext
Find and replace directory names
Enter old directory (use ‘*’ for all), or ? <options>: ?
Enter file references to list <*>: Enter
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Current REDIRMODE: Styles,Xrefs,Images,Rtext
TYPE NAME FILE
———————————————————————————
STYLE STANDARD TXT
STYLE 30-FLOR|STANDARD TXT
STYLE 30-FLOR|ROMANS ROMANS
STYLE 30-FLOR|COMPLEX COMPLEX
STYLE 30-FLOR|SIMPLEX SIMPLEX
STYLE 30-FACIL|STANDARD TXT
STYLE 30-FACIL|ROMANS ROMANS
STYLE 30-FACIL|COMPLEX COMPLEX
STYLE 30-FACIL|SIMPLEX SIMPLEX
XREF 30-FACIL D:\Dwg\30-facil.dwg
XREF 30-FLOR D:\Dwg\30-flor.dwg
Enter old directory (use ‘*’ for all), or ? <options>:

To use Redir to substitute a new path, follow the example prompt below.

Command: redir
Current REDIRMODE: Styles,Xrefs,Images,Rtext
Find and replace directory names
Enter old directory (use ‘*’ for all), or ? <options>: D:\Dwg
Replace “D:\DWG” with: Q:\Dwg\Xrefs
Searching for old dir: D:\DWG
in order to replace it with: Q:\DWG\XREFS
XREF 30-FLOR D:\Dwg\30-flor.dwg -> Q:\DWG\XREFS\30-FLOR.DWG
XREF 30-FACIL D:\Dwg\30-facil.dwg -> Q:\DWG\XREFS\30-FACIL.DWG
0 style/shape records modified.
0 image references modified.
2 xrefs modified.
0 rtext objects modified.
Changes to some externally referenced objects may be temporary.
Command:

Enter the Ridmode command or use the Options in the Redir command
to produce the REDIRMODE dialog box (Fig. 47-56).  Here you select
which objects you want to be affected by the Redir search and replace
you specify.

Web Tools Commands

The three commands in this group provide tools for manipulating hyperlinks in the current drawing.
The Show URLs command is explained previously with the ET: Standard toolbar group.

Figure 47-56
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Use Churls to edit the hyperlink (text information) attached
to an object.  The Churls command first prompts you to
select objects, then produces the Change URL dialog box in
which you can edit the contents of the selected hyperlink
(Fig. 47-57).  This is essentially the same dialog box that is
displayed when you select the Edit button of the Showurls
utility.

CHURLS COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Web tools>
Change URL CHURLS … …

Figure 47-57

This feature is useful for making global changes to mul-
tiple hyperlinks in a drawing, such as when an Internet
address or a path changes and you must update the text
information for all hyperlinks.  Repurls allows you to
change the hyperlink information for the selected
objects by searching for a text string and replacing it
with another.  At the “Select objects:” prompt select mul-
tiple objects containing hyperlinks to search and replace.
After selecting the desired objects, the Replace URL text dialog box opens with fields for you to enter the
Find what and Replace with text strings (Fig. 47-58).  For more information on using hyperlinks, refer to
Chapter 19, Internet Tools.

Tools Commands

The Tools group contains a collection of miscellaneous utilities, including the automation of creating
your own shapes and linetypes to enhanced UCS manipulation.

REPURLS COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Web tools>
Find and Replace URLs REPURLS … … … …

Figure 47-58

Aliasedit is a utility for changing specific command aliases from within AutoCAD, rather than using an
external text editor to modify the ACAD.PGP file.  For a review of the ACAD.PGP file refer to Chapter
44, Basic Customization.  

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Tools>
Command Alias Editor ALIASEDIT … … … …

ALIASEDIT
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Aliasedit produces the AutoCAD Alias Editor dialog box (Fig.
47-59).  Two tabs are available:  the Command tab for changing
command aliases, and the Shell Commands tab for modify-
ing shell (external to AutoCAD) commands.  Both tabs
operate similarly and include the following options.

Add
Select the Add button to open the New Command Alias dialog
box (not shown).  Create new command aliases (not previ-
ously defined) with this utility.  Enter the desired one- or
two-letter alias and select the AutoCAD command to which
you want it to be associated, then click OK to add it to the list.

Remove
To remove an alias from the list, select the alias from the list,
then click Remove.  This action removes the alias only, not the
AutoCAD command.

Edit
To modify an existing alias, select the alias from the list, then click the Edit button to open the Edit
Command Alias dialog box (not shown).  Make the desired (characters) changes to the alias, then click OK.
If the alias already exists, the Duplicates found alert box appears.

Import, Export
Selecting Import or Export from the File pull-down menu allows you to save the current .PGP file to
another name (Export) or to edit another .PGP file (Import).

When you click OK to complete the editing session, the aliases are saved to the appropriate .PGP file and
the AutoCAD session is updated with the changes (similar to using Reinit).  Checking the Confirm changes
check box results in an Overwrite….? alert upon selecting OK to complete the editing session.

Figure 47-59

COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express>
Tools>
System Variable Editor SYSVDLG … … … …

SYSVDLG

This utility is extremely useful for learning about
system variables and keeping track of and chang-
ing the variable’s settings.  Complete information
for each variable is given, such as a description of
each variable, the initial and current settings, and
where the variable is saved (registry or drawing
file).  In addition, you can use this utility to Save
the current settings for all system variables to a
.SVF file, then Read the file into another drawing,
which resets that drawing’s variables to the set-
tings specified in the .SVF file.

SYSDLG produces the System Variables dialog box
(Fig. 47-60).  The edit field above the list box

Figure 47-60
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allows you to enter a variable name or filter the list using a wildcard.  For example, entering DIM* in the
edit field filters the list to display only system variables that start with DIM.  To change the setting for a
particular variable, first select the variable from the list.  For all variables that are not read-only, you can
enter a value or string in the New Value edit field at the top of the dialog box.  You can specify edits for
several variables in this way, then select OK to apply all the changes.  No changes are committed until
the dialog is closed with the OK button.  

Save All
The Save All button produces a Save As dialog box in which you can save all or selected current variable
values to an .SVF (system variable) file or an .SCR (script) file.  Use Read to import an .SVF file.  .SCR files
can be read into AutoCAD by using the Script command.  If only one system variable is selected and the
list is not filtered, all the system variables are saved.  If more than one system variable is selected, only
the highlighted variables are saved.  

Read
The Read button produces the Open dialog box from which a saved .SVF file can be imported into the
current AutoCAD session.  Doing so resets the system variables for the AutoCAD session and for the
current drawing.  Be aware that this action overwrites system variable settings in the drawing you are
currently editing.

NOTE:  The DEFAULTS.SVF and the DEFAULTS.SCR files are provided that contain the default system
variable settings (as in a new installation of AutoCAD).  The files are located in the Express directory
along with the System Variable Editor.  You can either read the DEFAULTS.SVF file using Sysvdlg or run
the DEFAULTS.SCR file from the command line using the Script command to return AutoCAD to a “like
new” system variable state.

This linetype maker allows you to create linetypes in two ways.  First, you can create linetypes from an
existing pattern of lines and polylines and easily turn them into a linetype without going through the
typical linetype definition steps.  For example, assume you have a series of line segments that you wish
to use as your linetype “template.”  Use the Mkltype command, follow the prompts shown below to
select the existing line segments, and AutoCAD automatically creates and loads the new linetype.

Command: mkltype
(The Select File dialog box appears.  Enter the desired name for an .LIN file to store the new linetype.)
Enter linetype name: longdashes
Enter linetype description: Enter
Specify starting point for line definition:  PICK (first point to define segment length)
Specify ending point for line definition:  PICK (second point)
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: Enter
Linetype “LONGDASHES” created and loaded.
Command:

MKLTYPE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
Make Linetype MKLTYPE … … … …
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Secondly, you can use Mkltype to define the linetype using the typical linetype definition method.  You can
even include shape or text objects to create a complex linetype, as shown in the following series of prompts.

Command: mkltype
Enter linetype name: fence
Enter linetype description: a,1.5,-0.25,[“x”,standard,s=0.2,r=0.0,x=0.05,y=-0.1],

-0.4,1.5
Specify starting point for line definition: PICK (first point to define segment length)
Specify ending point for line definition: PICK (second point)
Select objects: PICK (to define object type)
Select objects: Enter
Linetype “FENCE” created and loaded.
Command:

Refer to Chapter 44, “Creating Custom Linetypes,” for information on linetype definitions.

Use this command to create shape files “on the fly” without having to go through the typical steps of
shape definition.  First, create some geometry composed of AutoCAD objects to use as the “template”
shape.  Next, use the Mkshape command and follow the prompts shown below to create the new shape
file.

Command: mkshape
(The Select File dialog box appears.  Enter the desired name for an .SHX file to store the new shape.)
Enter the name of the shape: square
Enter resolution <128>: Enter or (value)
Specify insertion base point: PICK
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: Enter
Determining geometry extents...Done.
Building coord lists...Done.
Formating coords...|Done.
Writing new shape...Done.
Compiling shape/font description file
Compilation successful.  Output file D:\A 2004 Instructor\Dwg\Ch47\newshapes.shx 
contains 135 bytes.
Shape “SQUARE” created.
Use the SHAPE command to place shapes in your drawing.
Command:

MKSHAPE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
Make Shape MKSHAPE … … … …
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The Real-Time UCS command allows you to manipulate the orientation of the User Coordinate System
(UCS) in real time.  The ability to easily manipulate the position and orientation of the UCS is very
important for creating and editing complex 3D drawings.  For more information, review Chapter 36,
User Coordinate Systems.

This command can best be utilized in a 3D view, so prior to using the command use 3Dorbit or other
viewing command to enable you to view the UCS from a 3D viewpoint.  When you begin Real-Time UCS,
the UCS icon displays a highlighted red X-axis, a yellow Y-axis and a green Z-axis, and the following
prompt is presented.

Command: rtucs
Press TAB key to change axis or
[Save/Restore/Delete/Cycle/Angle/Origin/View/World/Undo] <Drag to rotate> 

NOTE:  Contrary to the operation of other AutoCAD commands, do not press Enter after typing the
letter for the option you wish to use.  The following is a review of the function of each option.

Drag to Rotate
The default option allows you to dynamically change the orientation of the UCS by dragging your cursor
(place your cursor anywhere in the drawing area, then hold down the left button and drag).  In doing so,
the UCS rotates about one axis, the X axis being the initial default.  Use the Tab key to cycle to another
axis to rotate about.  As you drag your cursor, information regarding the current axis and the angle of
rotation is displayed on the left side of the Status bar. 

Save
Type S to be prompted to save the current UCS, then type a name for the current UCS.  The name then
appears in the UCS dialog box if opened (using the Dducs or Ucsman command).  

Restore
If one or more UCSs have been saved by name in the current drawing using the Save feature of either the
UCS command or Real-Time UCS, type R to cycle through the named UCS.  You cannot select the desired
name from a list, but instead typing R repeatedly makes each saved USC the current UCS.

Delete
Use this feature to delete a named UCS.  You are prompted for the name to delete. 

Cycle
Type C repeatedly to cycle through the six predefined positions of the UCS: World (Top), Front, Right,
Back, Left, and Bottom.  The information for each UCS is displayed on the left side of the status bar as each
becomes current.

Angle
By default, when you drag your cursor to rotate the UCS in real-time, rotation occurs in 15-degree incre-
ments.  Use this option to modify that value or turn it off by typing 0.

RTUCS COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
Real-Time UCS RTUCS … … … …
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Origin
Similar to the Origin option of the UCS command, use this option to reposition the origin of the UCS.
When using this feature, the orientation (X, Y, Z directions) of the UCS is retained.

View
The View option sets the XY plane to be parallel with the current display, with the X-axis set to horizon-
tal. This is similar to the View option of the UCS command.

World
Returns the UCS position to the World Coordinate System position for the current drawing.

Undo
Each time you type U the previous Real-Time UCS procedure is undone.

Extended entity data is additional information that can be attached to any AutoCAD object.  Extended
entity data provides an internal level of information “attached” to each individual object.  This
AutoCAD feature is extremely powerful for customization applications.

Xdata is an Express utility to simplify attaching extended entity data to an object.  Use Xdata to produce
the following prompt:

Command:  Xdata
Select object:  PICK
Enter application name:  (name)
(NAME) new application.
3Real/DIR/DISP/DIST/Hand/Int/LAyer/LOng/Pos/Real/SCale/STr/<eXit>: (option)
New xdata appended.
Command:

The prompt displays the areas of information that can be attached to an object:  3 Real numbers, 3D world
space direction, 3D world space displacement, Distance, Database handle, 16-bit integer, Layer, 32-bit long integer,
3D world space position, Real number, Scale factor, and ASCII string.

XDATA COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
Xdata Attachment XDATA … … … …

Xdlist lists extended entity data attached to a nested object.  An example is listed on the next page:

XDLIST COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
List Object Xdata XDLIST … … … …
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Command:  xdlist
Select object:  PICK
Enter application name <*>:  (name)
* Registered Application Name:  (NAME)
* Code 1002, Starting or ending brace: {
* Code 1000, ASCII string:
* Code 1003, Layer name: 0
* Code 1042, Scale factor: 0.5000
* Code 1000, ASCII string: sample object
* Code 1002, Starting or ending brace: }
Object has 16347 bytes of Xdata space available.

Fullscreen re-sizes the AutoCAD window to fill the maximum amount of screen area by hiding the
Windows title bar and the AutoCAD pull-down menu bar.  Fullscreen also hides the Status bar.  In full
screen mode, you can click at the top of the window to make the pull-down menu bar appear but you
cannot make the Status bar appear.  Use Fullscreen again to return the AutoCAD display to the previous
setting (normal screen mode).

FULLSCREEN COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
Full Screen AutoCAD FULLSCREEN … … … …

Both the (normal) Plan command and the Extended Plan command align the screen display to be coplanar
with the XY plane of the current UCS.  Stated another way, both commands change the orientation of
your view of the drawing so your line of sight is perpendicular to the XY plane.  Remember, these com-
mands change the view, not the orientation of the UCS.  (See Chapter 35, 3D Display and Viewing, for the
Plan command and its options.)

The difference between these commands is that with the (normal) Plan command, AutoCAD automati-
cally activates Zoom with the Extents option, so all of the drawing is visible after changing the view.  The
Extended Plan command, however, does not invoke a Zoom Extents, but enables you to specify what
objects you want to display after the view is changed.

Command: explan
Initializing...
Select objects to zoom to or press <enter> to select everything on screen...
Select objects: Enter
Enter an option [Current ucs/Ucs/World] <Current>: Enter
Regenerating model.

EXPLAN COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Express
Tools>
Extended Plan EXPLAN … … … …
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There are two options.  First, you can select the objects you want to display after the view is changed to a
plan view of the current XY plane.  Second, pressing Enter at the “Select objects” prompt causes the view
to change, but only those objects displayed previously are displayed after the view changes—AutoCAD
does not adjust the magnification of the drawing with Zoom Extents.  Therefore, you can Zoom to the
desired area of the drawing before using Explan, then press Enter at the “Select objects” prompt.

Additional Express Tools Commands, Command Line Entry Only

Commands in this section are not included in the Express toolbars or Express pull-down menus.  All of
these commands must be typed.

BLOCK?

This utility lists coordinate and other information about objects composing a Block definition as shown in
the following example:

Command:  block?
Block name/<Return to select>:  PICK
Enter an entity type/<Return for all>:  Enter
Press ESC to exit or any key to continue.

((0 . "BLOCK") (2 . "TBLOCK2") (70 . 2) (10 0.0 0.0 0.0) (-2 . <Entity name:
2b90668>))

((-1 . <Entity name: 2b90668>) (0 . "LWPOLYLINE") (5 . "65") (100 .
"AcDbEntity") (67 . 0) (8 . "0") (100 . "AcDbPolyline") (90 . 4) (70 . 0) (43 .
0.02) (38 . 0.0) (39 . 0.0) (10 -4.0 0.0) (40 . 0.02) (41 . 0.02) (42 . 0.0)
(10 -4.0 0.0) (40 . 0.02) (41 . 0.02) (42 . 0.0) (10 -4.0 1.625) (40 . 0.02)
(41 . 0.02) (42 . 0.0) (10 0.0 1.625) (40 . 0.02) (41 . 0.02) (42 . 0.0) (210
0.0 0.0 1.0))

((-1 . <Entity name: 2b90698>) (0 . "LINE") (5 . "6B") (100 . "AcDbEntity") (67
. 0) (8 . "0") (100 . "AcDbLine") (10 -4.0 0.375 0.0) (11 0.0 0.375 0.0) (210
0.0 0.0 1.0))

BCOUNT

The Bcount Express command counts and lists the number of Block insertions in each drawing or selec-
tion set.  You can count all Blocks in a drawing or specify a selection window.  The following example is
the Bcount results for the example schematic drawing used in Chapter 22:

Command:  count
Press enter to select all or…
Select objects:  Enter

Counting block insertions…Block  Count
----------
CAP ...... 3
RES ...... 3

Command:
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EXTRIM

Extrim allows you to use an existing Circle, closed Pline, Arc, Line, Ellipse, Image, or text as a “trimming
edge.”  Even though the normal Trim command allows closed Plines, this utility automates the process
by prompting only for “Side to Trim” and automatically trims all objects outside or inside the closed
boundary that cross the trimming edge object.  In other words, Extrim allows you to trim like using a
“cookie cutter” when closed objects are used as trimming edges.

Command: extrim
Pick a POLYLINE, LINE, CIRCLE, ARC, ELLIPSE, IMAGE or TEXT for cutting edge..
Select objects: PICK
Command:
Pick the side to trim on: PICK
Command:

MPEDIT

Mpedit is similar to Pedit with the additional capability to select multiple Plines for editing.  All selected
Plines are updated as a group.  For example, you can change the Width of all Plines in a drawing globally
with this feature rather than having to change one Pline at a time:

Command: mpedit
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: Enter
Convert Lines and Arcs to polylines? <Yes>: Enter
Enter an option [Open/Close/Width/Fit/Spline/Decurve/Ltype gen/eXit] <X>:

Although you may select only Plines, you will still get the “Convert Lines and Arcs to polylines? <Yes>:”
prompt.  All typical Pedit options are available (note the last prompt line).

TSCALE

This routine is virtually identical to the Scaletext command.  The only difference is in the order of the
options presented for the size change.  Refer to Chapter 18, Creating and Editing Text, to learn more
about the Scaletext command.  Tscale issues the following prompts:

Command: tscale
Select objects: PICK
Select objects: Enter
Specify justification to use as base point for scaling...
[Existing/Start/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR] <Existing>: Enter or option
Specify size change by [Scale (factor)/Height] <Height>: Enter
Final height <1’>: (value)
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SSX

SSX is a powerful utility that allows you to find objects of similar type (Circle, Arc, Line, etc.) for the
selection set by selecting only one object.  You can also specify a certain criteria.  This feature is simpler
than using Filter but can be almost as powerful.  Enter SSX at the command prompt to initialize the
routine, then enter “(SSX)” at any “Select objects:” prompt to use it.  For example, you can select all
similar objects (“Flatfile” block in this case) by selecting only one:

Command:  move
Select objects: (ssx)
Select object/<None>:  PICK
Filter: ((0 . "INSERT") (2 . "FLATFILE") (8 . "FURNITURE") (210 0.0 0.0 1.0))
>>Block name/Color/Entity/Flag/LAyer/LType/Pick/Style/Thickness/Vector:  Enter
10 found. 10 found
Select objects:  Enter
Base point or displacement:  PICK
Second point of displacement:  PICK
Command:

EXPRESSTOOLS

You can use the Expresstools command to make the AutoCAD Express Tools available in the current profile
if they are not yet available.  Expresstools places the Express directory on the search path, and loads and
places the Express menu on the pull-down menu bar.  The Express Tools must first be installed for this
command to operate (see “Installing the Express Tools from the CD-ROM” earlier this chapter). 

Once the Expresstools command is used, the Express Tools libraries load when AutoCAD is started.  This
increases the load time for AutoCAD but reduces the delay when you use one of the tools for the first
time.

EXPRESSMENU

Expressmenu loads the AutoCAD Express pull-down menu specifically.  If the Express Tool commands are
available on the command line but the Express pull-down menu is not displayed, use the Expressmenu
command to display the menu.


